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Purpose

Prerequisites

About This Guide

The TagMan® OpenArray® Genotyping Getting Started Guide provides information
about the OpenArray® system, including step-by-step procedures to:

* Prepare a TagMan® OpenArray® Genotyping Plate, using the OpenArray®
AutoLoader and OpenArray® Case Sealing Station.

e Run a TagMan OpenArray Genotyping Plate on the OpenArray® instrument,
then analyze the data with the OpenArray® SNP Genotyping Analysis Software.

e Maintain the OpenArray® platform.

This guide assumes that your OpenArray® platform has been installed by an Applied
Biosystems service representative.

This guide uses conventions and terminology that assume a working knowledge of the
Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Safety information

Safety alert words

Note: For general safety information, see this section and Appendix F, “Safety” on
page 135. When a hazard symbol and hazard type appear by a chemical name or
instrument hazard, see the “Safety” Appendix for the complete alert on the chemical or
instrument.

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert word —
IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of
observation or action, as defined below:

IMPORTANT! —Indicates information that is necessary for proper instrument operation
or accurate chemistry kit use.

CAUTION! -Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

TagMan® OpenArray® Genotyping Getting Started Guide 9



About This Guide
Safety information

SDSs

10

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most
extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems instruments
(see “Safety symbols” on page 136).

The Safety Data Sheets (SDSs) for any chemicals supplied by Applied Biosystems or
Ambion are available to you free 24 hours a day. For instructions on obtaining SDSs,
see “SDSs” on page 143.

IMPORTANT! For the SDSs of chemicals not distributed by Applied Biosystems or
Ambion contact the chemical manufacturer.

TagMan® OpenArray® Genotyping Getting Started Guide



Safety labels on instruments

About This Guide
Safety information

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in

the preceding section.

Hazard
symbol

English

Francais

>

CAUTION! Hazardous chemicals. Read the Safety
Data Sheets (SDSs) before handling.

CAUTION! Hazardous waste. Refer to SDS(s) and
local regulations for handling and disposal.

ATTENTION! Produits chimiques dangereux. Lire
les fiches techniques de siireté de matériels avant
toute manipulation de produits.

ATTENTION! Déchets dangereux. Lire les fiches

techniques de slreté de matériels et la régulation
locale associées a la manipulation et l'élimination
des déchets.

CAUTION! Hot surface.

ATTENTION! Surface brilante.

» B

CAUTION! Class 2(Il) visible and/or invisible laser
radiation present when using the instrument and
barcode scanner. Do not stare directly into the beam
or view directly with optical instruments.

ATTENTION! Rayonnement visible ou invisible d'un
faisceau laser de Classe 2(ll) en cas d’ouverture et
de neutralisation des dispositifs de sécurité. Ne pas
regarder le faisceau directement ou au travers d’un
instrument optique.

e B

CAUTION! UV LIGHT HAZARD. UV light may harm
your skin and eyes. Keep at least 25 cm distance.

CAUTION! Moving parts. Crush/pinch hazard.

ATTENTION! Dangers liés aux rayons UV. Les
rayons UV peuvent endommager votre peau et vos
yeux. Gardez une distance de plus de 25 cm.

ATTENTION! Pieces en mouvement, risque de
pincement et/ou d'écrasement.

TagMan® OpenArray® Genotyping Getting Started Guide
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CHAPTER 1

Introduction

This chapter covers:

System overview

System OVerview. .. ... 13
Plate OVeIVIEW. . . ... 15
About genotyping experiments . .............. . i 17
WOrKEIOW . . oo 19

The OpenArray® system uses fluorescence-based polymerase chain reaction (PCR)
reagents to provide qualitative detection of targets using post-PCR (endpoint)
analysis.

Use the OpenArray® system to perform genotyping experiments to identify slight
variations in genes within a population. The OpenArray® system:

Platform components

Provides PCR-based endpoint analysis of tens to hundreds of single nucleotide
polymorphism (SNPs) across thousands to tens of thousands of samples.
Allows a single researcher to load, amplify, and scan 16 TagMan® OpenArray®
Genotyping Plates in an 8-hour workday. Each genotyping plate is preloaded
with 16 to 256 TagMan® assays.

Provides data that is ~99.7% concordant with data generated with TagMan assays
on an Applied Biosystems Real-Time PCR System.

The OpenArray® platform consists of the following components:

OpenArray® AutoLoader — Loads your samples onto a TagMan® OpenArray®
Genotyping Plate.

OpenArray® Case Sealing Station — Seals the TagMan® OpenArray® Genotyping
Cases.

OpenArray® instrument — Performs imaging of the genotyping plates.

Computer — Connects to the OpenArray® instrument. The OpenArray® SNP
Genotyping Analysis Software installed on the computer analyzes the run data,
then calls the genotypes.

Note: You can also perform downstream analysis with Applied Biosystems
AutoCaller"" Software. For more information, see page 108.

TagMan® OpenArray® Genotyping Getting Started Guide 13



1 Chapter 1 Introduction
System overview

Thermal cycler
(purchased
separately)

Genotyping experiments require two steps: thermal cycling (PCR amplification),
followed by endpoint detection of the resulting fluorescence signals.

While the OpenArray® instrument performs the endpoint detection, you need a
standalone thermal cycler to perform PCR amplification. Purchase a thermal cycler
that has been qualified for use with the TagMan® OpenArray® Genotyping Plates. The
following thermal cyclers are qualified for use with the genotyping plates:

* Dual Flat Block GeneAmp® PCR System 9700

* Bio-Rad® thermal cycler with Slide Chambers Dual Block Alpha Unit

¢ Thermo Electron PX2 thermal cycler

Note: Contact your Applied Biosystems service representative for more information
on the thermal cyclers.

About data collection

14

The OpenArray® instrument collects raw fluorescence data after thermal cycling (PCR
amplification) has been performed. A data collection point (datapoint) on the
OpenArray® instrument consists of three phases:

1. Excitation — The instrument illuminates all through-holes of the genotyping plate,
exciting the fluorophores in each reaction.

2. Emission — The instrument optics collect the residual fluorescence emitted from
the through-holes of the genotyping plate. The resulting image consists only of
light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval, then stores the raw fluorescence
image for analysis.

After a run, the OpenArray software uses regions of interest (ROI), optical, dye, and
background calibration data to determine the location and intensity of the fluorescence
signals in each read, the dye associated with each fluorescence signal, and the
significance of the signal.

TagMan® OpenArray® Genotyping Getting Started Guide



Chapter 1 Introduction
Plate overview
Plate overview

The OpenArray® system requires two plate types:

» OpenArray® 384-Well Sample Plate (sample plate) (this page)
¢ TagMan® OpenArray® Genotyping Plate (genotyping plate) (page 16)

Sample plate

The OpenArray 384-Well Sample Plate is a 384-well reaction plate. You combine the
TagMan® OpenArray® Genotyping Master Mix and your DNA sample in the sample
plate, then use the OpenArray AutoLoader to transfer the mixture from the sample
plate to a genotyping plate(s).

IMPORTANT! The well dimensions of the OpenArray 384-Well Sample Plates are
specifically suited for use with the OpenArray AutoLoader. Applied Biosystems does
not recommend the use of other microtiter plates with the AutoLoader.

TagMan® OpenArray® Genotyping Getting Started Guide 15



1 Chapter 1 Introduction
Plate overview

TagMan® OpenArray® Genotyping Plate

The TagMan OpenArray Genotyping Plate is a 63-mm x 19-mm mid-density reaction
plate. There are 3072 reaction through-holes in the plate; individual through-holes are
preloaded with a TagMan assay and can accommodate a 33-nL reaction volume.

As shown in the figure below, the genotyping plate is divided into 48 subarrays; each
subarray consists of 64 through-holes. Hydrophilic and hydrophobic coatings allow
reagents to be held within the through-holes.

1 2 3 4 5 6 7 8 9 10 1 12

A
B
° 1\
D
A}
a [00000000
b 88888888 Each subarray has
c
00000000 these 64 through-
O0000000 holes.
f\ |O0000000 ]
g\ | 000000+ For example, this
h \{OO000000 is A1g7.
12345678

Available Taq Man® When you order a genotyping plate, you select the TagMan assay(s) to include in the
assays plate. The assays are dried-down and preloaded into the genotyping plate. You can
select any combination of the following:

e TagMan® SNP Genotyping Assays
* Custom TagMan® SNP Genotyping Assays
e TagMan® Drug Metabolism Genotyping Assays

Available formats Each through-hole in a genotyping plate may contain a single assay. The number of
assays in the genotyping plate and the number of samples you can load in the plate
depend on the format you select. For more information on each format, see “Set up the
sample plates” on page 33.

16 TagMan® OpenArray® Genotyping Getting Started Guide
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About genotyping experiments

About genotyping experiments

What is a genotyping experiment?

A genotyping experiment (also known as an allelic discrimination experiment) is an
endpoint experiment used to determine the genotype of unknown samples. With this
experiment type, you can differentiate two alleles of a single nucleotide polymorphism
(SNP).

A genotyping experiment determines if unknown samples are:

¢ Allele 1 homozygotes (samples having only allele 1)
¢ Allele 2 homozygotes (samples having only allele 2)
* Heterozygotes (samples having both allele 1 and allele 2)

Components Genotyping experiments include the following samples and controls:
¢ Sample - The DNA sample in which the genotype of the target is unknown.

* (Optional) Replicates — Identical reactions containing identical components and
volumes.

* (Optional) No template controls (NTCs) — Samples that contain water or buffer
instead of template; also known as negative controls. NTCs should not amplify.

* (Optional) Positive controls — Samples that contain known genotypes
(homozygotes for allele 1, homozygotes for allele 2, and heterozygotes for alleles
1 and 2).

How TagMan® genotyping experiments work

In TagMan® genotyping experiments, the PCR includes a specific fluorescent-dye-
labeled probe for each allele of the target SNP. The probes contain different fluorescent
reporter dyes to differentiate each allele.

When you order a genotyping plate, you select the assay(s) appropriate for your
experiment (see “Available TagMan® assays” on page 16). The assays are dried-down
and preloaded into the genotyping plate. Each assay contains:
* A reporter dye at the 5 end of each probe:
- VIC® dye is linked to the 5" end of the allele 1 probe
- FAM"™ dye is linked to the 5’ end of the allele 2 probe
— Forward primer
— Reverse primer
¢ A minor groove binder (MGB)

This modification increases the melting temperature (Tm) of probes without
increasing probe length (Afonina et al., 1997; Kutyavin et al., 1997), thereby
allowing the design of shorter probes. Consequently, the TagMan MGB probes
exhibit greater differences in Tm values between matched and mismatched
probes; greater differences in Tm values provide accurate genotyping.

* A nonfluorescent quencher (NFQ) at the 3° end of the probe

Because the quencher does not fluoresce, real-time PCR systems can measure
reporter dye contributions accurately.

TagMan® OpenArray® Genotyping Getting Started Guide 17



1 Chapter 1 Introduction
About genotyping experiments

Mismatches
between probe and
allele sequences

18

During PCR, each probe anneals specifically to its complementary sequence between
the forward and reverse primer sites. The DNA polymerase can cleave only probes
that hybridize to their specific SNP allele (match). Cleavage separates the reporter dye
from the quencher dye, substantially increasing fluorescence of the reporter dye. Thus,
the fluorescence signals generated during PCR amplification indicate the alleles that
are present in the sample.

The figure below illustrates results from matches and mismatches between target and
probe sequences in TagMan SNP Genotyping Assays (Livak et al., 1995). A mismatch
between a probe and a SNP allele greatly reduces the efficiency of probe hybridization.
Furthermore, the DNA polymerase is likely to displace the mismatched probe rather
than to cleave it to release reporter dye. In other words, matches generate signal;
mismatches do not generate signal.

Allele a@g
1 Legend
] I ” IC I u | I | | C IWET W @ vorae
Match Mismatch ® FAM™ dye
@ Quencher
Allele
2 "
AmpliTaq
i l I "( > l H I I l@ I " I l( ) Gold® DNA
Il II | @ Polymerase
Match Mismatch GR1556

The table below summarizes the possible results of the genotyping experiment
example shown above.

A substantial increase in... Indicates...
VIC® dye fluorescence only Allele 1 homozygotes
FAM™ dye fluorescence only Allele 2 homozygotes
VIC® dye and FAM™ dye fluorescence Heterozygotes

TagMan® OpenArray® Genotyping Getting Started Guide
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Workflow
Workflow

Chapter 2, Prepare the OpenArray® 384-Well Sample Plates

1. Prepare the DNA samples.

2. Set up the OpenArray® 384-Well Sample Plates. Sample plate setup is dependent on the
format of your TagMan® OpenArray® Genotyping Plates.

3. Load the DNA samples into the sample plates.

|

Chapter 3, Prepare the TagMan® OpenArray® Genotyping Plates

4. (Optional] Store the sample plates.

1. Prepare for loading.

N

Place a TagMan® OpenArray® Genotyping Plate in an OpenArray® AutoLoader Plate
Holder.

Load the OpenArray® Autoloader Tip Blocks.
Run the OpenArray® Autoloader.
Seal the TagMan® OpenArray® Genotyping Case.

|

Chapter 4, Perform Imaging

oo~

Perform thermal cycling.

1. Set up the OpenArray® SNP Genotyping Analysis Software.
2. Enter sample information in the OpenArray software.

3. Place the loaded TagMan® OpenArray® Genotyping Plates in the OpenArray® instrument,
then perform an imaging run.

Chapter 5, Analyze the Run Data

View the results.

(Optional) Modify clustering parameters.
(Optional) Modify project files (*.nix).
(Optional) Publish data.

a -

(Optional) Perform downstream analysis using the AutoCaller™ Software.

TagMan® OpenArray® Genotyping Getting Started Guide 19
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CHAPTER 2

Prepare the OpenArray® 384-Well
Sample Plates

This chapter covers:

Required materials.......... ... 22
Prepare the DNA samples. . ... 23
Create a sample information file (*.csv) for sample tracking. ................ 25
Use the Sample Tracking & Calculator Tool............................... 25
Use a spreadsheet or simple text program ................. ... ... .. ... 30
Export sample information from an existing *nix file . ..................... 30
Setupthesampleplates ............ . ... .. ... 33
Format16.. ... .. 35
Format32. ... .. 37
Format 64 . ... ... . 39
Format 128 . ... .. 40
Format192. ... ... . 41
Format256. ... .. . 42
Load DNA samples and master mix into the sample plate(s)................ 43
(Optional) Store sealed sampleplates.................................... 44

In this chapter, you prepare your DNA sample, set up the OpenArray® 384-Well
Sample Plates, then load your DNA sample into the sample plates. In Chapter 3, you
will use the OpenArray® AutoLoader to transfer sample from the prepared sample
plates to TagMan® OpenArray® Genotyping Plates.

Chapter 2, Prepare the OpenArray® 384-Well Sample Plates

1. Prepare the DNA samples.

2. Set up the OpenArray® 384-Well Sample Plates. Sample plate setup is dependent on the
format of your TagMan® OpenArray® Genotyping Plates.

3. Load the DNA samples into the sample plates.
4. (Optional] Store the sample plates.

TagMan® OpenArray® Genotyping Getting Started Guide 21



2 Chapter 2 Prepare the OpenArray® 384-Well Sample Plates
Required materials

Required materials

Product Source Part Number

For preparing your DNA samples

TagMan® RNase P Detection Reagents Kit Applied Biosystems 4316831

This kit contains RNase P gene primers and
probe: 20X Primer and TagMan® Probe
(FAM™ dye) mix.

TagMan® DNA Template Reagents Kit Applied Biosystems 401970
This kit contains DNA template standards.

TagMan® Universal PCR Master Mix, No Applied Biosystems 4324018
AmpErase® UNG

Genomic DNA sample User-supplied -—

See “Prepare the DNA samples” on page 23.

DNase-free, sterile-filtered water Major laboratory -—
suppliers (MLS)

For setting up and loading the sample plates

OpenArray® 384-Well Sample Plates Applied Biosystems 4406947
(Optional) Fine-tip marker MLS -—
TagMan® OpenArray® Genotyping Master Mix | Applied Biosystems 4404846
Corning® 96 Well Microplate Aluminum | Corning Life Sciences | 6570

Sealing Tape, Nonsterile

For general use

Powder-free nitrile gloves MLS —_—
Lint-free wipes MLS —
Disposable transfer pipettes | MLS |-
Pipettes, P10 to P1000 MLS o
Pipette tips, 10 to 100 pL MLS —
Centrifuge with plate adaptor MLS -—
Vortexer . MLS . S

22 TagMan® OpenArray® Genotyping Getting Started Guide



Chapter 2 Prepare the OpenArray® 384-Well Sample Plates 2
Prepare the DNA samples

Prepare the DNA samples

Quality of DNA

Quantity of DNA

Be sure that the DNA you use for genotyping experiments:
¢ Isextracted from the raw material you are testing with an optimized protocol;
salting out procedures and crude lysates are not recommended
¢ Does not contain PCR inhibitors
* Has an Ajyggn30 ratio between 1.7 and 1.9
* Has an Ayg)pg0 ratio between 1.7 and 1.9
* Isintact as visualized by gel electrophoresis

* Has not been heated above 60 °C; temperatures above 60 °C can cause
degradation

Applied Biosystems recommends that you quantify the amount of genomic DNA in
your samples. Note that:

* The OpenArray plate requires 250 copies of haploid genome for each individual
through-hole reaction.

¢ For optimal cluster plot results, it is important to normalize all genomic DNA
samples in an experiment so that each through-hole receives the same input
quantity of sample.

For an example quantification procedure, see “Quantification procedure for human
DNA samples” (this page).

Quantification procedure for human DNA samples

Template amount

The recommended amount of template for each through-hole reaction in an
OpenArray plate is 250 copies of the haploid genome, equivalent to 0.84 ng for human
DNA samples. Quantify human DNA samples using the TagMan® RNase P Detection
Reagents Kit and the TagMan® DNA Template Reagents Kit.

Note: The recommended starting concentration for human DNA samples is 50 ng/uL.
See Appendix C, “DNA Calculator” on page 123.

TagMan® OpenArray® Genotyping Getting Started Guide 23



2 Chapter 2 Prepare the OpenArray® 384-Well Sample Plates
Prepare the DNA samples

Quantify human Generate a standard curve using the DNA template standards provided in the TagMan
DNA samples DNA Template Reagents Kit and the RNase P gene primers and probe provided in the
TagMan RNase P Detection Reagents Kit.

Note: Refer to the appropriate instrument user guide for detailed instructions on
performing and analyzing runs.

1. Create and set up a sequence detector plate document.

2. Prepare the reaction plate using the following components:
e 2X TagMan® Universal PCR Master Mix, No AmpErase® UNG
¢ 20X Primer and TagMan® Probe (FAM™ dye) mix
* DNA template standard or genomic DNA sample
¢ DNase-free, sterile-filtered water

Use at least three replicates of each standard or sample, and use all five DNA
standards to ensure an accurate standard curve is generated. The range of known
copy number should bracket anticipated copy numbers of the unknown samples
on the same reaction plate.

3. Run the reaction plate on an Applied Biosystems Real-Time PCR System using
the following thermal cycling conditions:

AmpliTaq Gold®

enzyme activation PCR
HOLD CYCLE (40 cycles)
Denature Anneal/extend
Time 10 min 15 sec 1 min
Temp 95°C 92°C 60°C

4. Generate a standard curve to quantify the amount of DNA in each sample.

The recommended starting concentration for human DNA samples is 50 ng/uL. See
Appendix C, “DNA Calculator” on page 123.

24 TagMan® OpenArray® Genotyping Getting Started Guide



Chapter 2 Prepare the OpenArray® 384-Well Sample Plates 2
Create a sample information file (*.csv) for sample tracking

Create a sample information file (*.csv) for sample tracking

Most researchers maintain stocks of gDNA samples in individual tubes or in 96-well
stock plates. However, samples to be used with the OpenArray® system must be
transferred first to a OpenArray® 384-Well Sample Plate, and then to a TagMan®
OpenArray® Genotyping Plate.

IMPORTANT! To ensure accurate data results, you must correctly track the sample IDs

from format to format.

Applied Biosystems recommends that you create a sample information file (*.csv) to
track your samples. Prior to imaging the genotyping plates, you can import the *.csv
file into the OpenArray software.

You can create a sample information file in one of three ways:
* (Recommended) Use the Sample Tracking & Calculator Tool (this page)
* Use a spreadsheet or simple text program (page 30)
* Export sample information from an existing *.nix file (page 30)

Include no template controls

Applied Biosystems strongly recommends that you include at least one no template
control (NTC) per genotyping plate. NTCs serve as negative controls, and are also
useful in data analysis. When adding NTCs to the 96-well stock plate, place one NTC
in each section of the stock plate to ensure that the NTCs are plated in the correct
location in the genotyping plate. Also follow this procedure for any positive controls
(for example, CEPH DNA).

Use the Sample Tracking & Calculator Tool

About the Sample
Tracking &
Calculator Tool

Standard vs.
modified
spreadsheet

The Sample Tracking & Calculator Tool is a spreadsheet created with the Microsoft®
Excel® Software. Applied Biosystems provides the Sample Tracking & Calculator Tool
during training.

Applied Biosystems recommends that you use the Sample Tracking & Calculator Tool
to convert the sample IDs to the appropriate format. When you use the tool, you only
need to enter the sample IDs once, then the process of transferring the sample
information from format to format is automatic.

To ensure that the samples are tracked correctly, you must use an appropriate
spreadsheet in the Sample Tracking & Calculator Tool. The spreadsheet that you use
depends on:

* The OpenArray plate format that you are loading the samples into (Format 16, 32,
64, 128, 192, or 256) and

¢ The method that you use to transfer the samples from individual tubes or 96-well
stock plates to the OpenArray 384-Well Sample Plate(s)

Applied Biosystems provides a standard spreadsheet in the Sample Tracking &
Calculator Tool. You can use the standard spreadsheet if you load samples into a
Format 64 (64 x 48) genotyping plate and you use a 12-channel pipette to transfer
samples. Otherwise, you must modify the standard spreadsheet to create the correct
*.csv file for imaging.
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Edit the spreadsheet

26

Note: If you are unfamiliar with the Excel software, you can contact Applied
Biosystems Technical Support for help with modifying the spreadsheet.

Example in this section

The standard spreadsheet was used for the example experiment illustrated in this
section. In the example experiment:

* The Format 64 genotyping plate (64 x 48) was used.

* A 12-channel pipette with 9-mm spacing was used. The 384-well sample plates
have 4.5-mm spacing; due to the 9-mm spacing of the pipette, sample was added
to every other well in the 384-well sample plate. That is, all samples from row A of
the 96-well plate were transferred to the odd-numbered wells of row A in the 384-
well sample plate; all samples from row B of the 96-well plate were transferred to
the even-numbered wells of row A in the 384-well sample plate, and so on.

1. Open the Sample Tracking & Calculator Tool to start the Excel software.

2. Select the Entry for Samples — List Format tab.

& 5  [wemm o ]| 3 —F & T A ] T T i ] T M T W[ o6 [
1 | 96 well plate # Well Location Sample ID 96 well plate #f Well Location Sample ID 96 well plate #f Well Location Sample ID 96 well plate # Well Localion Sample D~
2 Il 201 2 3 )
3 1 A02 z 402 3 A02 4 A02
4 [l 03 2 03 3 03 ) 03
5 1 A4 2 A04 3 A04 4 A04
3 Al Al Al Al
7 Al Al Al Al
8 Al Al Al Al
9 Al Al Al Al
o Al Al Al Al
n [l A0 2 £ 3 A0 ) A0
2 1 Al = Aan i an 4 Aan
[ Il iz 2 2 3 a2 ) A2
i) 1 B0 v B0l e} B0l 4 B01
B 1 B2 2 B2 3 B2 4 B02
€ 1 B03 2 B03 k| B03 4 Bo3
w 1 B4 2 B4 3 B4 4 B4
B 1 B0S 2 B5 3 BS 4 B0
i) 1 BOE 2 BE 3 BE 4 B0&
20 1 BO7 2 Bo7 2 B07 4 B07
1 B8 B8 B8 B8
B03 B0 B0 B0
B B0 B0 B0
Bit B B B
B2 B2 B2 B2
2 [l o 2 ol 3 con ) o
27 1 coz2 £ coz2 3 coz 4 coz
2 Il o3 2 03 3 03 ) 03
29 1 Co4 z Co4 3 Co4 4 Co4
30 1 cos 2 cos 3 cos 4 cos
3 1 C6 2 C06 3 C06 4 CO08
Cl & Ol =
C CI CI CI
CI [n B B
[ C [ £
B |51 & C
37 [l e 2 e 3 e ) cr v
i 4 » 0\ Instructions \Entry for Samples- List Format, Entry for Samples- PI‘ < >
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3. Enter the sample IDs next to the appropriate well locations. You can enter up to
four 96-well plates per spreadsheet (four 96-well plates are equal to one 384-well

sample plate).

A \ B | c |

1 | 96 well plate # Well Location Sample ID
2 1 A1 N1
3 1 AQ2 N2
4 1 AQ3 N3
5 1 A04 N4
5} 1 AQ5 NS
7 1 AQB NTC
8 1 AQ7 NE
9 1 A08 N7
10 1 A9 NB
11 1 A10 N9
12 1 Al N10
13 1 A12 NTC
14 1 BO1 N1
15 1 B0O2 N12
16 1 B0O3 N13
17 1 BO4 N14
18 1 B0O5 N15
19 1 BOB N16
20 1 BO7 N17
21 1 B0O3 N18
22 1 B09 N19
23 1 B10 N20
24 1 B11 N21
25 1 B12 N22

For each 96-well plate in the
spreadsheet, the sample IDs are
color-coded in groups of six,
using alternate colors.

4. Select the Entry for Samples — Plate Format tab, then confirm that the three plate

views correspond to the layout of your stock gDNA plate:

Plate view Example

96-well plate views 1 2 3 4 5 6 7 8 9 10 " 12

[up to four 96-well plates] A N1 N2 N3 N4 NG NTC NG N7 N8 N9 N10 NTC
B N11 N12 N13 N14 N15 N16 N1T N18 N19 N20 N21 N22
c N23 N24 N25 N26 N27 N28 N29 N30 N34 N32 N33 N34
D N35 N36 N37 N38 N39 N4O N41 N42 N43 Nd4 N4§ Nd6
E N47 N48 N49 N50 N&1 N2 NE3 N64 NS5 N6 N57 NES
F N9 N60 N6 N62 N63 N64 N5 N66 N67 N68 N69 NT0
G N71 N72 NT73 N74 NT5 N76 NTT N78 N79 N8O N81 NB2
H N83 N84 N85 N86 N87 Pos N8 N8BS Neo NO1 No2 Pos
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Plate view Example
384-well pLate view 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
[one 384-Well plate] A N[ N1 | N2 [ N12 | N3 [N13 | N [ N14 | NS [N15 [NTC|N16 [ N6 | N17 | N7 |N18 | N8 | N19 | N9 | N20 | N10 | N21 | NTC | N22
B NZ3 [ N35 | N24 | 36 | N25 | M3T | N26 [ N38 | N27 [ N3G [ N28 | M40 [ N29 | NA1 | N30 [ N42Z | N31 [ N43 | N32 | NA4 | N33 | N45 | N34 | N46
c NAT [ NS | N4G | MBO | N4 | N1 | NSO [ NB2 | N51 | NE3 [ NS2 | B4 | NS3 | N5 | N54 [ NES | NS5 | N6 | NS6 | N6S | N5T | NB2 | N58 | N70
b NT1 [ N83 | N72 | M84 | N73 | M85 | NT4 [ N86 | N75 | N8T [ INT6 | Pas [ N77 | N88 | N78 [ N8 | IN79 [ N9 | N8O | N1 | Mg | Na2 | N82 | Pos
E oflo|ofoflojo|lo|fo|ofo|Jof[o|lo|o|o|o|o|[o|o|o|o[oO|[0O]|oO
F oflo|ofoflojo|lo|fo|ofo|Jof[o|lo|o|o|o|o|[o|o|o|o[oO|[0O]|oO
G ofo|ofoflofofjofo|ofo]J]o[o|lo|o|o|o|o|[o|o|o|o[oO|0O]|o®O
H oflo|ofoflojo|lo|fo|ofo|Jof[o|lo|o|o|o|o|[o|o|o|o[oO|[0O]|oO
| ofo|ofoflojo|lo|o|ofo|Jo[o|lo|o|o|o|o|[o|o|o|[o[oO|[O]|oO
J ofo|ofoflojo|lo|o|ofo|Jo[o|lo|o|o|o|o|[o|o|o|[o[oO|[O]|oO
K ofo|ofoflojo|lo|o|ofo|Jo[o|lo|o|o|o|o|[o|o|o|[o[oO|[O]|oO
L ofo|ofoflojo|lo|o|ofo|Jo[o|lo|o|o|o|o|[o|o|o|[o[oO|[O]|oO
M ofo|ofoflojo|lo|fo|ofo|Jo[o|o|o|o|o|o|[o|o|o|o[oOo|O]|oQO
N ofo|ofoflojo|lo|fo|ofo|Jo[o|o|o|o|o|o|[o|o|o|o[oOo|O]|oQO
° ofo|ofoflojo|lo|fo|ofo|Jo[o|o|o|o|o|o|[o|o|o|o[oOo|O]|oQO
P ofo|ofoflojo|lo|fo|ofo|Jo[o|o|o|o|o|o|[o|o|o|o[oOo|O]|oQO
Genotyping plate views (up to S ‘ s
1 H 1 2 3 4 5 ] 7 ] 9 0112 1 2 3 4 5 1] 7 8 10 112
elght genOtyplng plates] A N1 [ N1 | N2 | N12 | N2 | N13 | N4 | N#4 | N5 | N15 (NTC| N16 | NE | NT7 | N7 [ N18 | N8 [ N19 | N9 | N20 | N10 | N21 |[NTC| N22
B N23 | N35 | N24 | N36 | N25 | N37 | N26 [ N38 | N27 | N39 | N28 | N40 | N29 | N41| N30 | N42 | N31 | N43 | N32 | N44 | N33 | N45 | N34 | N46
c N47 [ N59 | N48 | NGO | N49 | N61 | NS0 | N62 | N51T| NE3 | NS2 | NG4 | NS3 | NG5 | NS94 | NG6 | NS5 [ N67 | NS6 | N68 | N57 | N69 | N98 | N70
D N71|N83 | N72 | N84 | N73 | N85 | N74 | N86 | N75 [ N87 | N76 | Pos [ N77 | N8B | N78 [ N89 [ N79 [ NS0 | N80 | N91 | N81 | N92 | N82 | Pos
OpenArray 3 | OpenArray 4
1 2 3 4 5 E 7 8 9 0112 1 2 3 4 5 1] 8 0 112
A 0 0 0 0 0 o L] L] 0 0 0 0 0 o L] L] L] 0 0 0 0 L] L]
B o o i) 0 0 o o o o o i) 0 0 o o o o o i) 0 0 o o
c 0 0 0 0 0 o o o 0 0 0 0 0 o o o o 0 0 0 0 o o
D o o i) 0 0 o o o o o i) 0 0 o o o o o i) 0 0 o o
Openarray § OpenArray 6
1 2 3 4 5 6 7 8 9 10 n 12 1 2 3 4 5 6 7 8 10 L1 12
A o o 0 0 0 o o o o o 0 0 0 o o o o o i} 0 0 o o
B [ [ 0 0 0 o L] L] [ [ 0 0 0 o L] L] o o 0 0 0 L] L]
c o o 0 0 0 o o o o o 0 0 0 o o o o o i} 0 0 0 o o
D [ [ 0 0 0 o L] L] [ [ 0 0 0 o L] L] o o 0 0 0 0 L] L]
OpenArray 7 [ OpenArray 8
1 2 3 4 5 6 7 8 9 10 n 12 1 2 3 4 5 6 7 8 9 10 n 12
A o o i) 0 0 o o o o o i) 0 0 o o o o o i) 0 0 0 o o
B L] L] 0 0 0 o o o L] L] 0 0 0 o o o L] L] 0 0 0 0 o o
C o o i) 0 0 o o o o o i) 0 0 o o o o o i) 0 0 0 o o
D L] L] 0 0 0 o o o L] L] 0 0 0 o o o L] L] 0 0 0 0 o o
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5. (Optional) To track the eight plate areas of the 384-well sample plate to the eight
genotyping plates, you can enter barcodes into the corresponding boxes. The
barcode is located on the genotyping plate and on its packaging.

OpenArray 1

OpenArray 2

OpenArray 3

OpenArray 4

DpenArray 5

OpenArray 6

OpenArray 7

OpenArray 8

Generate the *.csv 1. Select File » Save to save the spreadsheet in the Excel software.
file

2. Save the spreadsheet as a *.csv file:
a. Select File » Save As.
b. Browse to a save location, enter a file name, then select *.csv as the file type.
c. Click Save.
The figure below is an example of a *.csv file generated with the Sample Tracking
& Calculator Tool (the figure includes only a partial list of sample information).
Prior to imaging the genotyping plate, use this file to import sample information

into the OpenArray software, as described in “Import sample information from a
*.csv file” on page 71.

SamplePlate.SelectedArealndex SamplePlate.SerialNumber Samplelnfo.Address Samplelnfo.SamplelD

0 Al N1
0 A2 N13
0 A3 N2
0 Ad N14
0 A5 N3
0 A6 N15
0 A7 N4
0 A8 N16
0 A9 N5
0 A10 N17
0 IXE N6
0 A12 N18
0 A13 N7
0 Al4 N19
0 A15 N8

TagMan® OpenArray® Genotyping Getting Started Guide 29



2 Chapter 2 Prepare the OpenArray® 384-Well Sample Plates
Create a sample information file (*.csv] for sample tracking
Use a spreadsheet or simple text program

1. Open a new file in a simple text program or in a spreadsheet program (such as
Microsoft® Excel® Software).

2. (Recommended) Label the file with the same unique identifier as the sample
plate.

3. In Row 1, enter the column headings:

a. You must include the following columns:

Column heading Column description

Samplelnfo.Address The well address of the sample on the
sample plate (for example, A1)

Samplelnfo.SamplelD Identifying information for the sample
(user-defined)

Samplelnfo.Description A description of the sample (user-defined)

b. (Optional) Add new columns (user-defined) to the right of the required
columns.

4. In the remaining rows, enter information for each sample in the sample plate.
Follow these guidelines:

* Include all samples and all NTCs in the sample plate.
¢ Enter information for only one sample per row.

Note: You can have a maximum of 385 rows: One row for the column headings, and
up to 384 rows with sample information.

5. Save the file as a comma-delimited (*.csv) file. Prior to imaging the genotyping
plate, use this file to import sample information into the OpenArray software, as
described in “Import sample information from a *.csv file” on page 71.

Export sample information from an existing *.nix file

1. On the computer, start the OpenArray software:
e Double-click the software icon @
or

* Select Start » All Programs » BioTrove » OpenArray® SNP Genotyping
Analysis Software <version number>» OpenArray® SNP Genotyping
Analysis Software.

The software opens a new (empty) project file (*.nix).

2. Select File » Open, then browse to and select the desired project file (*.nix).
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Note: Applied Biosystems does not recommend exporting sample information from
one type of genotyping plate format to create a *.csv file for a different type of format.

For example, if you want to create a *.csv file for Format 16, select a *.nix file that
contains sample information from a Format 16 genotyping plate.

3. In the Samples pane, select a sample from a genotyping plate that contains the

information you want to export.

Note: You can export sample information for only one genotyping plate at a time. If

you select more than one sample, the software will export information for the
genotyping plate that contains the last sample you selected.

4. 1In the Samples pane, click Edit to open the Sample Information dialog box for the
selected sample.

B0262 VF

11780 Mo Call
50059 Mo Call

Mo Call
Mo Call

BJ584.1.0
BJ584.2.0
BJ584.53.0
BJ584.4.0
BJ584.5.0
BJ584.8.0
BJ584.7.0
BJ584.8.0
BJ584.9.0
BJ584.10.0
BJ584.11.0
BJ584.12.0
BJ584.13.0
BJ584.14.0
BJ584.15.0
BJ584.16.0
BJ584.17.0

aa2833

F EN N N U S £ R N N N N N N

9. Export the sample information to one *.csv file for all loads (1 to 3 loads) or to a
separate *.csv file for each load:

¢ To export to one *.csv file for all loads (1 to 3 loads):

a. In the Sample Information dialog box, click Export.

Sample Information For BJS84

=

222893

222895

Selected Samples
Load Number | Plate ID
882643

882643

882643

882643

882643

882643

882643

882643

882643

882643

882643

882643

222843
222843
222843
222893

222883
222893
222883

1
1
1
1
1
1
1
1
1
1
1
1
1 222843
1
1
1
2
2
2
2
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Address
ca
cio
cil
ciz
D
D2
D3
D4
D5
D8
D7
D8
D3
D10
D11
D12
E
Al4
Al5
ATB

Sarmple ID
21418
45945
31837
74220
68690
74472
65488
58605
38668
83074
15768
48608
50865
38549
45147
22712

Dilution
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

Description &
Treatment C3
Treatment C.
Treatment C.
Treatment C.
Treatment D1
Treatment D2
Treatment D3
Treatment D4
Treatment D5
Treatment DB
Treatment D7
Treatment D8
Treatment D3
Treatment D.
Treatment D.
Treatment D.

Cancel
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b. Browse to a save location, enter a file name, then click Save. The software
exports the sample information for 1 to 3 loads into a single *.csv file.

Note: The software exports only the rows required for the selected plate
areas. The software does not export all 384 rows for each of the sample
plates.

* To export to a separate *.csv file for each load:

a. Click ll next to appropriate load number to open the Sample Plate dialog
box.

c. Browse to a save location, enter a file name, then click Save. The software
exports the sample information for the selected load into a *.csv file.

Note: The software exports only the rows required for the selected plate
area. The software does not export all 384 rows of the sample plate.
d. Click OK to close the Sample Plate dialog box.
e. Repeat steps 1 through 4 above for the remaining load(s).
6. Open the new *.csv file, using a spreadsheet or simple text program (such as

Microsoft® Excel® Software). The *.csv file should include the column headings
and data exported from the software.

7. If needed, edit the sample information in the following columns:

Column heading Column description
Samplelnfo.SamplelD Identifying information for the sample (user-
defined)
Samplelnfo.Description A description of the sample (user-defined)

Note: The software exports several columns. Do not alter the column headings or data
for any of the remaining exported columns.
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8. (Optional) Add new columns (user-defined) to the right of the exported columns.

9. Save and close the file. Prior to imaging the genotyping plates, you can import the
sample information into the OpenArray software, as described in “Import sample
information from a *.csv file” on page 71.

Set up the sample plates

About the sample plate

The OpenArray 384-Well Sample Plate is a 384-well microtiter plate. You combine the
TagMan® OpenArray® Genotyping Master Mix and your DNA samples in the sample
plate, then use the OpenArray AutoLoader to transfer the mixture from the sample
plate to a genotyping plate.

The sample plate is divided into eight areas; each sample plate area is 12 wells x 4
wells (48 wells). During each load, the AutoLoader transfers sample from one area of a
single sample plate.

Plate Area 4 (detail)
Columns 13-24

Columns 1-12 Columns 13-24

/A 2 4 L] ] 0 12 14 16 18 20 2 24 ============
GRRY Sl B - Plate area 1| Plate area 2 Rows E-H (S EOOO00ODO LD
g 7W 000000000oon
SRl - Plate area 3| | [Plate area 4 ‘ |
SN o - Plate area 5 |- Plate area 6
ORIV RN O - Plate area 7 |- [Plate-area8
N

IMPORTANT! The way you set up the sample plates in this section depends on the
format of the genotyping plate that you will be transferring your DNA samples to in
Chapter 3.
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TagMan® OpenArray® Genotyping Plate formats

There are six TagMan® OpenArray® Genotyping Plate formats available. As shown in
the table below:

* The total number of samples that you can load into the sample plate depends on
the TagMan® OpenArray® Genotyping Plate format.

* A single genotyping plate can accept one to three loads from one to three sample
plates, respectively, depending on how many samples per subarray are required.

TaqMan® OpenArray® Genotyping Plates
Maximum no. of Required no. of Required no. of Page
Format samples per
samples per plate loads number
subarray
16 144 3 3 page 35
32 96 2 2 page 37
b4 48 1 1 page 39
128 24 1 1 page 40
192 16 1 1 page 41
256 12 1 1 page 42
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Format 16
Format 16 of the genotyping plate is preloaded with 16 assays. You can load up to 144
samples into Format 16. To properly load Format 16:

¢ Set up three sample plates.

* When transferring the samples with the AutoLoader (page 54), perform three
separate loads. The AutoLoader transfers the sample from one 12-well x 4-well
area on three separate sample plates.

Set up three sample 1. Label three sample plates with a unique identifier.

plates Note: You enter this identifier when you set up the project file (*.nix) in the
OpenArray® SNP Genotyping Analysis Software. See “Set up the software” on
page 66.

2. Determine how to arrange the samples in each sample plate. If needed, you can
mark the sample plates with a fine-tip marker.

IMPORTANT! Be sure to track where the samples are in each sample plate. For
each sample plate, Applied Biosystems recommends creating a sample
information file (*.csv). See page 25.

Applied Biosystems recommends the following arrangement:
* For sample plate 1, load samples 1 to 48 in one area of the sample plate.
e For sample plate 2, load samples 49 to 96 in one area of the sample plate.
¢ For sample plate 3, load samples 97 to 144 in one area of the sample plate.

For example:

Sample plate 1 Sample plate 2 Sample plate 3
Plate area1 Wgt:e area 2 Plate area 2 Plate area 1 Wgtf area 2
’\‘ “vead read ‘ F\ “vead ‘
‘A N ‘?‘ N
& | b q B b
Pl N Ple Pi& .
‘ | e | N
v v
\‘ Sample 1 Sample 49 ‘\‘Samp\e 97
\ L \
OEENNEEENEEEE \ )
OEEEEE =) \
EEEEEE |
IIIIIIIIIIILIr
Sample 48 Sample 96 Sample 144
Load 1 Load 2 Load 3

Sample 1

[elaisinioloinio}
[eRUtUN 1o}

Subarray A1

Sample 97

Sample 48

OpenArray plate SEIIETR ) subarray D12
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Subarray locations

36

When you transfer the samples from the sample plates to Format 16, program the
AutoLoader to perform three loads. The AutoLoader transfers the samples to the
following locations in each subarray of the genotyping plate:

Sample plate

Load

Genotyping plate subarray locationst

Through-holes A1 through B8

Through-holes D1 through E8

Through-holes G1 through H8

T Rows C and F in each subarray will be empty.
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Format 32
Format 32 of the genotyping plate is preloaded with 32 assays. You can load up to 96
samples into Format 32. To properly load Format 32:

¢ Set up two sample plates.

* When transferring the samples with the AutoLoader (page 54), perform two
separate loads. The AutoLoader transfers the sample from one 12-well x 4-well
area on two separate sample plates.

Set up two sample 1. Label two sample plates with a unique identifier.
plates Note: You enter this identifier when you set up the project file (*.nix) in the

OpenArray software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in each sample plate. If needed, you can
mark the sample plates with a fine-tip marker.

Note: Be sure to track where the samples are in each sample plate. For each
sample plate, Applied Biosystems recommends creating a sample information file
(*.csv). See page 25.

Applied Biosystems recommends the following arrangement:
e For sample plate 1, load samples 1 to 48 in one area of the sample plate.
¢ For sample plate 2, load samples 49 to 96 in one area of the sample plate.

For example:

Sample plate 1 Sample plate 2
Pla!e area 1 ”Ngte area 2 late area 2
N Svgas | L weas |
& N | B |
\l‘a‘ " Ple ‘
. ~
\‘ Sample 1 . Sample 49
\ CNNEEEEEEEEE
= =
= =
ODNEENNEEEEEE
Sample 48 Sample 96
Load 1 Load 2

Subarray A1

-t HE:

L

Sample 48

OpenArray plate Subarray D12

TagMan® OpenArray® Genotyping Getting Started Guide 37



2 Chapter 2 Prepare the OpenArray® 384-Well Sample Plates
Set up the sample plates

Subarray locations

38

When you transfer the samples from the sample plates to Format 32, program the
AutoLoader to perform two loads. The AutoLoader transfers the samples to the
following locations in each subarray of the genotyping plate:

Sample plate

Load

Genotyping plate subarray locations

Through-holes A1 through D8

Through-holes E1 through H8
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Format 64
Format 64 of the genotyping plate is preloaded with 64 assays. You can load up to 48
samples into Format 64. To properly load Format 64:
¢ Set up one sample plate.
* When transferring the samples with the AutoLoader (page 54), perform one load.
The AutoLoader transfers the sample from one 12-well x 4-well area on one
sample plate.
Set up one sample 1. Label one sample plate with a unique identifier.
plate Note: You enter this identifier when you set up the project file (*.nix) in the
OpenArray software. (See “Set up the software” on page 66.)
2. Determine how to arrange the samples in the sample plate. If needed, you can
mark the sample plate with a fine-tip marker.
IMPORTANT! Be sure to track where the samples are in the sample plate. Applied
Biosystems recommends creating a sample information file (*.csv). See page 25.
Applied Biosystems recommends that you load samples 1 to 48 in one area of the
sample plate. For example:
Sample plate
,/’ “\t:earees
II’ ‘\aria/
Sample 1 . ]
Subarray A1
EEmEmEEmmma
[ [ [ [ [ [ [ [ [ W=~
OpenArray plate SULSE! ) Subarray D12
—"
Subarray locations When you transfer the samples from the sample plate to Format 64, program the

AutoLoader to perform one load. The AutoLoader transfers the samples to the
following locations in each subarray of the genotyping plate:

Sample plate Load Genotyping plate subarray locations

1 1 Through-holes A1 through H8
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Set up the sample plates

Format 128

Format 128 of the genotyping plate is preloaded with 128 assays. You can load up to 24
samples into Format 128. To properly load Format 128:

¢ Set up one sample plate.

* When transferring the samples with the AutoLoader (page 54), perform one load.
The AutoLoader transfers the sample from one 12-well x 4-well area on one
sample plate.

Set up one sample 1. Label one sample plate with a unique identifier.

plate

Note: You enter this identifier when you set up the project file (*.nix) in the
OpenArray software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in the sample plate. If needed, you can
mark the sample plate with a fine-tip marker.

IMPORTANT! Be sure to track where the samples are in the sample plate. Applied
Biosystems recommends creating a sample information file (*.csv). See page 25.

Applied Biosystems recommends that you load samples 1 to 24 in one area of the
sample plate, in duplicate. For example:

Sample plate

" Plate area 1 \‘Plale area 2
4

.
'{ale area 4

T
te area 6
futetic)

X
\area 8
|

l
.

’ \
Sample 1
Sample 24
Subarray A1 Sample 1

Sample 1
suwaray o1 | [t HEEEEEEEEEN

N

YN

Sample 24 Subarray C12

OpenArray plate bl | Subarray D12

N

Subarray locations When you transfer the samples from the sample plate to Format 128, program the
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AutoLoader to perform one load. The AutoLoader transfers the samples to the
following locations in each subarray of the genotyping plate:

Sample plate Load Genotyping plate subarray locations

1 1 Through-holes A1 through H8
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Set up the sample plates

Format 192

Format 192 of the genotyping plate is preloaded with 192 assays. You can load up to 16
samples into Format 192. To properly load Format 192:
¢ Set up one sample plate.

* When transferring the samples with the AutoLoader (page 54), perform one load.
The AutoLoader transfers the sample from one 12-well x 4-well area on one
sample plate.

Set up one sample 1. Label one sample plate with a unique identifier.

plate Note: You enter this identifier when you set up the project file (*.nix) in the
OpenArray software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in the sample plate. If needed, you can
mark the sample plate with a fine-tip marker.

IMPORTANT! Be sure to track where the samples are in the sample plate. Applied
Biosystems recommends creating a sample information file (*.csv). See page 25.

Applied Biosystems recommends that you load samples 1 to 16 in one area of the
sample plate, in triplicate. For example:

Sample plate

l’ Plate area 1 \‘F'Iahe area 2 ‘
4

\
Yate area s |
‘te area 6
Narea 8

’
J
/
’
/
y
'
/ v
’ \
Sample 1
Subarray A1 Subarray A2 Subarray A3
Sample 16
Sample 1 Sample 1 Sample 1
(copy 1) (copy 2)

(HEEEEEEEEEEE
EEEEEEEEEE l
EEEEEEEEEN

IIIIIIIII(III)

OpenArray plate
sample 16 | Sample 16 | Sample 16
(copy 1) (copy 2)

Subarray D10 Subarray D11 Subarray D12

Subarray locations When you transfer the samples from the sample plate to Format 192, program the
AutoLoader to perform one load. The AutoLoader transfers the samples to the
following locations in each subarray of the genotyping plate:

Sample plate Load Genotyping plate subarray locations

1 1 Through-holes A1 through H8
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Set up the sample plates

Format 256
Format 256 of the genotyping plate is preloaded with 256 assays. You can load up to 12
samples into Format 256. To properly load Format 256:
¢ Set up one sample plate.
* When transferring the samples with the AutoLoader (page 54), perform one load.
The AutoLoader transfers the sample from one 12-well x 4-well area on one
sample plate.
Set up one sample 1. Label one sample plate with a unique identifier.
plate Note: You enter this identifier when you set up the project file (*.nix) in the
OpenArray software. See “Set up the software” on page 66.
2. Determine how to arrange the samples in the sample plate. If needed, you can
mark the sample plate with a fine-tip marker.
IMPORTANT! Be sure to track where the samples are in the sample plate. Applied
Biosystems recommends creating a sample information file (*.csv). See page 25.
Applied Biosystems recommends that you load samples 1 to 12 in one area of the
sample plate, in quadruplicate. For example:
Sample plate
Subarray A1 @ / i @ Subarray A12
Sample 1 H Sample 12
Subarray B1 Subarray B12
Subarray C1 Subarray C12
[ [ [ [T T[T T
Subarray D1 S(Zo'"p'i,'z; .l.....----.l- S::r:s;esl)z Subarray D12
el ||| [T IS
([ EEEEEEEEEEE
OpenArray plate
Subarray locations When you transfer the samples from the sample plate to Format 256, program the

AutoLoader to perform one load. The AutoLoader transfers the samples to the
following locations in each subarray of the genotyping plate:

Sample plate Load Genotyping plate subarray locations

1 1 Through-holes A1 through H8
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Load DNA samples and master mix into the sample plate(s)

Load DNA samples and master mix into the sample plate(s)

1. Atroom temperature, thaw the DNA samples. Mix the DNA samples by
vortexing, then spin for 1 minute @ 1000 rpm.

2. Review the concentration of the normalized genomic DNA samples.

The recommended starting concentration for human DNA samples is 50 ng/uL.
See Appendix C, “DNA Calculator” on page 123.

3. Mix the TagMan® OpenArray® Genotyping Master Mix by gently inverting the
tube 10 times.

4. Add the master mix and the normalized DNA samples to the OpenArray 384-
Well Sample Plate. For human DNA samples, use the amounts listed below per
well of the sample plate.

IMPORTANT! As noted in the table below, the component amounts vary,
depending on the format of the genotyping plate that you will later transfer to the

samples to.
Volume (pL) per wellt, when
transferring to...
Component
Format 16 | Format 32 All other
formats

Normalized human DNA sample 1.5 2.0 2.5
Starting concentration = 50 ng/uL
TagMan® OpenArray® Genotyping Master | 1.5 2.0 2.5
Mix, 2X
Total volume 3.0 4.0 5.0

1t One well of a sample plate corresponds to one subarray of a TagMan OpenArray Genotyping Plate.
5. Mix well by gently pipetting up and down.
6. Cover the sample plate with sealing tape.

7. Spin the sample plate for 1 minute @ 1000 rpm to eliminate bubbles.

Proceed to Chapter 3, “Prepare the TagMan® OpenArray® Genotyping Plates” on page
45.

Note: If needed, you can store the sealed sample plates. See page 44.
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(Optional) Store sealed sample plates

(Optional) Store sealed sample plates

You can prepare multiple sample plates, then store them until needed.

Storing sealed sample plates

After you load the OpenArray 384-Well Sample Plates with DNA samples and master
mix (page 43), you can store the sealed sample plates at 4 °C for up to 24 hours.

Using stored sample plates
To use a sample plate that has been stored per the above conditions:
1. Thaw the sample plate at room temperature.

2. Before removing the sealing tape, spin the sample plate for 1 minute @ 1000 rpm.

Proceed to Chapter 3, “Prepare the TagMan® OpenArray® Genotyping Plates” on page
45.
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CHAPTER 3

Prepare the TagMan® OpenArray®
Genotyping Plates

This chapter covers:

Required materials.......... ... 46
Storage conditions .......... ... .. 48
Prepare for loading. . ......... ... 49
Place a TagMan® OpenArray® Genotyping Plate in a plate holder . .......... 50
Load the OpenArray® AutoLoader Tip BIOCKS . . ... .vvvtviiei e 52
Run the OpenArray® AutoLoader. ... .........ouiuiriuainini e, 54
Seal the TagqMan® OpenArray® Genotyping Case . ................c.ou.... 58
Perform thermal cycling .......... .. ... 61
Guidelines for high-throughputloading ................................. 62

In this chapter, you use the OpenArray® AutoLoader to transfer your DNA samples
from the OpenArray® 384-Well Sample Plates (prepared in Chapter 2) to TagqMan®
OpenArray® Genotyping Plates.

Chapter 3, Prepare the TagMan® OpenArray® Genotyping Plates

1. Prepare for loading.

N

Place a TagMan® OpenArray® Genotyping Plate in an OpenArray® AutolLoader Plate
Holder.

Load the OpenArray® AutoLoader Tip Blocks.
Run the OpenArray® AutolLoader.
Seal the TagMan® OpenArray® Genotyping Case.

e p~»

Perform thermal cycling.
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Required materials

Required materials

TagMan® OpenArray® Genotyping Plates

The following table provides a list of available formats for the TagMan® OpenArray®

Genotyping Plates.
®
TagMan ® Number of Maximum no. of samples
OpenArray Part number assays er OpenArray sample plate
Genotyping Plate Y P P y plep
Format 16 4413546 16 144

32 4413548 32 96

b4 4413550 b4 48

128 4413551 128 24

192 4413553 192 16

256 4413554 256 12
Ordering the For information on ordering the TagMan® OpenArray® Genotyping Plates:
TagMan®
Open Array® 1. Go to www.appliedbiosystems.com.
Genotyping Plates

yping 2. Click the link for TaqMan® SNP Genotyping Assays.

3. Click the link for TaqMan® OpenArray® Genotyping Plates.

4. Click the Ordering Information tab.
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Other consumables and equipment

Required materials

Product Source Part Number
For loading the TagMan® OpenArray® Genotyping Plates
OpenArray® Plate Guide Set Applied Biosystems 20292
OpenArray® AutolLoader Tip Block Applied Biosystems 20322
Finnpipette Multichannel Digital Pipettor, Applied Biosystems 4452470
5to 50 uL
OpenArray® Loader Tips Applied Biosystems 4404571
OpenArray® Loader Tips 10 Pack Applied Biosystems 4404604
OpenArray® AutoLoader Plate Holder Applied Biosystems 20384
OpenArray® AutolLoader Applied Biosystems 4409360
For sealing the TagMan® OpenArray® Genotyping Plates
TagMan® OpenArray® Genotyping Applied Biosystems 4404572
Accessories Kit
The accessories kit contains:
o TagMan® OpenArray® Genotyping Case
e OpenArray® Sealing Glue
 OpenArray® Immersion Fluid
OpenArray® Case Sealing Station Applied Biosystems 4409361
Ethanol® Major Laboratory -—

Suppliers (MLS)

Razor blade MLS —
25 Slide Holder Applied Biosystems 4407056

For thermal cycling the genotyping plates, use one of the following thermal cyclers, which
have been qualified for use with the genotyping plates:

e Dual Flat Block GeneAmp® PCR System
9700

Applied Biosystems 4428234

e Bio-Rad® thermal cycler with Slide
Chambers Dual Block Alpha Unit

e Thermo Electron PX2 thermal cycler

Contact your Applied biosystems service
representative for more information on the
thermal cyclers.

For general use

Powder-free nitrile gloves MLS —
Laboratory-grade wipes MLS —
Forceps MLS —
3 Plastic bins [medium to large) for washing | MLS -
the tip blocks and plate holders
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Storage conditions

Product

Source Part Number

(Optional) Filtered 100% compressed
nitrogen gas or residue-free compressed air
canister, for drying the plate holder, tip
blocks, and plate guides.

(Optional) Hand-held spray attachment for
the compressed gas/air canister

MLS —

MLS -

1 For the SDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer. Before

handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.

Storage conditions

48

The following materials require special storage conditions:

Item

Storage Conditions

TagMan® OpenArray® Genotyping Plate

If the TagMan®
OpenArray®

Frozen, unopened

Store at 20 °C until the expiration date
provided on the product label.

Genotyping Plate is...
Thawed, unopened

Store at room temperature for up to
24 hours.

Thawed, opened

Loaded and sealed,
pre-thermal cycling

Store at room temperature for up to 1 hour.

Store at room temperature, in the dark, for
up to 72 hours.

Loaded and sealed,
post-thermal
cycling

Store at 4 °C, in the dark, for up to 72 hours.

OpenArray® Immersion Fluid

See the product label for storage conditions
and expiration date. After you open the
package, do not store any remaining
immersion fluid; use the amount required,
then discard the remainder.

OpenArray® Loader Tips

See the product label for storage conditions
and expiration date. After you open the
package, discard any unused tips after

2 weeks.

OpenArray® Sealing Glue

Store the glue in a dark place; ambient light
can cure the glue in the tip. If the glue has
been open more than 2 weeks, discard it and
use a new tube.
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Prepare for loading

Prepare for loading

1. Be sure that the OpenArray® Plate Guide Set, OpenArray® AutoLoader Tip
Blocks, and OpenArray® AutoLoader Plate Holder are completely clean and dry.

For cleaning procedures, see “OpenArray® AutoLoader and accessories” on page
112.

IMPORTANT! Residual water prevents correct loading of the samples into the
TagMan OpenArray plates.

2. Fill the appropriate number of TagMan® OpenArray® Genotyping Cases with
OpenArray® Immersion Fluid:

a. Using scissors, open a container of immersion fluid.

b. Place the case in the case rack and fill it approximately 2/3 of the way with
immersion fluid.

IMPORTANT! Within 1 hour after opening the container of immersion fluid, fill the
case with immersion fluid, insert a loaded genotyping plate, then seal the
case.

3. Remove the genotyping plates from the freezer, but do not open the packaging.
Allow the genotyping plates to thaw at room temperature (approximately 5
minutes).

Note: Unopened genotyping plates can remain at room temperature for up to 24
hours.

IMPORTANT! Thaw only the genotyping plates you will need for the current
loading session.

Proceed immediately to “Place a TagMan® OpenArray® Genotyping Plate in a plate
holder” on page 50.
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Place a TagMan® OpenArray® Genotyping Plate in a plate holder

Place a TagqMan® OpenArray® Genotyping Plate in a plate holder

Important guidelines for handling the plate

* Wear gloves that are one size smaller than the size you typically wear, to help
prevent excess glove material from contacting the genotyping plate while
loading.

* Hold the genotyping plate by the edges, at the end opposite from the barcode. Do
not touch the through-holes.

o Within 1 hour after opening the plate packaging, load the genotyping plate with
sample, place the loaded plate in a TagMan OpenArray Genotyping Case, then
seal the case.

¢ If you drop a loaded genotyping plate, discard it in the appropriate waste
container.

Place the plate in the plate holder

1. Remove a thawed genotyping plate from its packaging.

Note: You may want to save the genotyping plate packaging, as you can scan the
barcode on the package to enter the genotyping plate serial number into the
software. See “Enter the TagMan® OpenArray® Genotyping Plate serial number”
on page 67.

2. Orient the OpenArray® AutoLoader Plate Holder so that the latch is towards you.

3. Orient the genotyping plate so that the barcode faces up and to your left.
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Place a TagMan® OpenArray® Genotyping Plate in a plate holder

4. Pull the latch on the plate holder towards you, as shown below. The genotyping
plate drops into place. Be sure that the genotyping plate reaches all the way to the
right of the plate holder, then release the latch.

i

5. With clean tweezers, push the genotyping plate flat. Push the tweezers against all
four corners and the edges, carefully avoiding the through-holes. The numbered
side of the genotyping plate should be level with the plate holder.

-

.

O

ﬁk/

S L A e

J

Proceed immediately to “Load the OpenArray® AutoLoader Tip Blocks” on page

52.
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Load the OpenArray® Autoloader Tip Blocks

Load the OpenArray® AutoLoader Tip Blocks

52

1.

Using tweezers, peel the sealing tape from the area of the sample plate that
contains the samples to be transferred.

From the OpenArray® Plate Guide Set, select the plate guide that aligns with the
12-well x 4-well areas in the sample plate:

* One plate guide is for sample plate areas 1, 3, 6, and 8 (shown below).
* One plate guide is for sample plate areas 2, 4, 5, and 7.

Place the plate guide over the sample plate.

IMPORTANT! Be sure that the plate guide sits flat on the benchtop. The plate guide
should not be tilted by the sample plate beneath it. To check the plate guide
position, gently slide the plate guide across the benchtop. If the plate guide is not
aligned correctly, it slips toward the base of the sample plate.

Place the tip block into the appropriate area of the plate guide.

For example, place the tip block in position 1 to load the tips with samples from
sample plate area 1. Sample plate area 1 includes wells Al to A12, B1 to B12, C1 to
C12, and D1 to D12. For an illustration of the sample plate areas, refer to “Set up
the sample plates” on page 33.
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Load the OpenArray® Autoloader Tip Blocks

5. Using the Finnpipette Multichannel Digital Pipettor (or by hand), place 12
OpenArray® Loader Tips in each hole of the tip block (one row). Release the tips
when they are submerged.

IMPORTANT! Do not press firmly when inserting the tips into the tip block. Let the
tips drop into the tip block slots.

T T T 1_‘_”1 L e n‘(v,," “
—{hAb A} S Place 12 tips into the tip block as

t‘f‘f‘f‘f"‘“‘ff‘f‘fw shown. If you are using the digital
pipettor, four channels will be
empty.

6. Slide the tip block up and down (25 to 50 times), until the tips:
e Are filled to 1 mm above the bottom edge of the tip block.
¢ Have no air bubbles.

You can remove the tip block to look at the tips. When you replace the tip block to
load more sample, be sure to:

* Level the tip heights.

* Keep the tip block in the same orientation. If you turn the tip block around,
the samples will mix together and become contaminated.

~Amm e L e e e e e ) e e

IMPORTANT! If the tips are not filled correctly, product performance may be
adversely affected.
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Run the OpenArray® Autoloader

7. Leave the tip block with the loaded tips in the plate guide, keeping the tips
submerged in sample, until the genotyping plate is ready for loading.

FETTTTYTIY S

8. If you are transferring samples from additional sample plates (see “Set up the
sample plates” on page 33), repeat steps 2 through 7 for each sample plate.

Proceed immediately to “Run the OpenArray® AutoLoader”.

Run the OpenArray® AutoLoader

Use the OpenArray® AutoLoader to load the TagMan® OpenArray® Genotyping
Plates (that is, transfer samples from the sample plate onto genotyping plates).
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Run the OpenArray® AutolLoader

Set up the AutolLoader

For the following hazards, see the complete safety alert descriptions in Appendix F,
“Safety”:

WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and cut.
Keep hands clear of moving parts while operating the instrument.

1. Power on the AutoLoader. The AutoLoader homes the platform, then displays:
Welcome, AutoLoader Ready! Press Enter to Start

2. Press ENTER. The screen displays:

Samples/Subarray:
ENTER: #
NEXT: More Choices

where # is the number of loads the AutoLoader will perform: ONE, TWO, or
THREE

3. Press ENTER to accept the current number, or press NEXT until the correct
number appears, then press ENTER. Be sure to select the correct number of loads
for your genotyping plate:

Geno:zl:::gtplate No. of loads
Format 16 THREE
Format 32 TWO
Format 64 ONE
Format 128 ONE
Format 192 ONE
Format 256 ONE

Note: If you need to change the number of loads that you entered, press
CANCEL, then at the “Continue with the Cancel” prompt, press ENTER.
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Run the OpenArray® Autoloader

4. At the prompt, place the genotyping plate and plate holder on the AutoLoader
platform. The notch in the plate holder should face the instrument.

5. Gently push the plate holder all the way down.
6. Press ENTER to send the platform to the load position.

7. At the prompt, insert the loaded tip block (from step 7. on page 54):

IMPORTANT! Insert the loaded tip block only when prompted.

a. Place the loaded tip block above the genotyping plate.
b. Align the tip block with the metal guide pins on the AutoLoader.

C. Bring the tip block straight down, without tilting it. Slowly position the tip
block over the metal guide pins.

IMPORTANT! Perform this step slowly and evenly to prevent improper
sample loading (for example, too much sample or not enough sample).

8. Be sure the tip heights are level:

a. Gently slide your finger across the tops of the tips so that the tip heights are
level.
Or

b. Gently rest another tip block on top of the tips until the tip heights are level,
then remove the tip block.

IMPORTANT! For the AutoLoader to properly load the genotyping plate with
sample, the tip heights must be level.
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Run the OpenArray® AutoLoader

Load the sample

IMPORTANT! After you press ENTER (step 1. below), you cannot stop the AutoLoader.
If you want to stop the AutoLoader before you begin loading sample, press STOP now.
The AutoLoader ends the current operation, calibrates, then returns to the Welcome
screen. If you are prompted to remove the tip block, you must remove the tip block to
proceed.

1. On the AutoLoader, press ENTER. The samples in each tip are loaded in the
appropriate through-holes.

2. At the prompt, remove the tip block:

a. Slowly pull the tip block straight up, without any rocking motion. To prevent
rocking, it may be helpful to hold the tip block with your index finger and
thumb, and press your remaining fingers against the AutoLoader surface.

Note: To ensure that the samples are uniformly loaded in the genotyping
plate, remove the tip block slowly and evenly.

b. Press ENTER.

Note: If you programmed the AutoLoader to perform two or three loads, you are
prompted to remove the current tip block and insert the next tip block. Remove
the tip block following the steps above; insert the next tip block per the steps in
“Set up the AutoLoader” on page 55.

3. Follow the prompts to remove the plate holder from the AutoLoader platform.

4. Remove the genotyping plate from the plate holder:
¢ Place the plate holder on a flat surface.

* Push the latch down, then carefully lift the genotyping plate from the plate
holder with one hand.

¢ With the other hand, grasp the edge of the genotyping plate and lift it out.

IMPORTANT! Hold the genotyping plate by the edges, at the end opposite
from the barcode. Do not touch the through-holes. If you drop a loaded
genotyping plate, discard it in the appropriate waste container.

To prevent evaporation of the samples, proceed immediately to “Seal the TagMan®
OpenArray® Genotyping Case” on page 58.
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Chapter 3 Prepare the TagMan® OpenArray® Genotyping Plates

Seal the TagMan® OpenArray® Genotyping Case

Insert the loaded plate into a TagMan® OpenArray® Genotyping Case

1.

Hold the genotyping plate by its edges, at the end opposite from the barcode,
with the barcode facing up.

IMPORTANT! Do not touch the through-holes. If you drop a loaded genotyping
plate, discard it in the appropriate waste container.

Slide the genotyping plate into a TagMan OpenArray Genotyping Case. Be sure
that the:

Plate aligns with the grooves in the case. Misalignment may cause surface
rubbing, loss of samples, and/or contamination.

Genotyping plate barcode is at the top of the case and facing the black,
painted side of the case.

==
-

~

Push the genotyping plate all the way down into the case. Use tweezers if
needed.

If needed, adjust the level of immersion fluid with a pipette. The immersion
fluid should be level with the genotyping plate.

Discard leftover immersion fluid in an appropriate waste container.

Seal the TagMan® QOpenArray® Genotyping Case

Use the OpenArray® Sealing Glue and the OpenArray® Case Sealing Station to seal the
TagMan OpenArray Genotyping Case so that immersion fluid does not leak during
thermal cycling or imaging.

IMPORTANT! If the glue has been open more than 2 weeks, discard it and use a new
tube. Store the glue in a dark place; ambient light can cure the glue in the tip.

58
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Seal the TagMan® OpenArray® Genotyping Case

For the following hazards, see the complete safety alert descriptions in Appendix F,
“Safety”:

A@t’x WARNING! ULTRAVIOLET LIGHT HAZARD.

1. Fill the case with glue:

a. Place a drop of glue on one edge of the case opening, then fill until the glue
reaches the top of the case. Angle the tip so that the glue reaches the inside
rail.

b. Repeat step 1.a. on the other edge of the case opening.

c. Continue adding glue on each side until the glue runs together in the middle.
Fill the case to the top. Be sure that both the left and right sides are covered
with glue.

2. If you see air bubbles in the immersion fluid underneath the glue, use a small
pipette to carefully aspirate the bubbles.

3. With a lint-free wipe, wipe any excess glue from the surface of the glass.
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4. Cure the glue:

a. Place the case(s) in the sealing station so that the barcode faces out, then close
the door. You can place up to two cases at a time in the sealing station.

b. Turn the switch to ON and allow the glue to cure for 90 seconds.

c. Turn the switch to OFF, then remove the cases.

Clean the TagMan® OpenArray® Genotyping Case

IMPORTANT! Be sure to clean each TagMan OpenArray Genotyping Case thoroughly.
Dust, glue, or excess sample on the case may interfere with thermal uniformity and can
fluoresce. While cleaning, do not squeeze the case; gently hold the case to ensure the
glass does not touch the genotyping plate through-holes.

For the following hazards, see the complete safety alert descriptions in Appendix F,
“Safety”:

1. If there is any glue on a case, carefully remove the glue with a razor blade. Be sure
not to scratch the glass.

2. Moisten a lint-free wipe with ethanol, then gently wipe the case surface.

3. Allow the case to air-dry, or spray each side of the case with compressed air for
2 seconds.

Proceed to “Complete loading for the remaining plates” on page 61.

Note: After the loaded genotyping plate is sealed, you can store it at room
temperature, in the dark, for up to 72 hours.
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Perform thermal cycling

Complete loading for the remaining plates

Before you begin thermal cycling, repeat the following procedures to load the
remaining genotyping plates:
* “Prepare for loading” on page 49
e “Place a TagMan® OpenArray® Genotyping Plate in a plate holder” on page 50
* “Load the OpenArray® AutoLoader Tip Blocks” on page 52.
e “Run the OpenArray® AutoLoader” on page 54
» “Seal the TagMan® OpenArray® Genotyping Case” on page 58

Proceed to “Perform thermal cycling”(this page).

Perform thermal cycling

Qualified thermal cyclers

You must perform thermal cycling on a thermal cycler that has been qualified for use
with the genotyping plates. As part of the qualification process, the thermal cycler
must be programmed with a thermal cycling protocol that is appropriate for the
genotyping plates.

When your OpenArray® platform is installed, the Applied Biosystems service
representative also installs the thermal cycling protocol on your qualified thermal
cycler.

The following thermal cyclers are qualified for use with the TagMan Open Array
plates:

* Dual Flat Block GeneAmp® PCR System 9700 — The Dual Flat Block GeneAmp®
PCR System 9700 has been developed and validated for efficient and accurate
thermal cycling of the genotyping plates. The Dual Flat Block sample module can
cycle up to eight genotyping plates simultaneously. For the thermal cycling
protocol, refer to the Dual Flat Block GeneAmp® PCR System 9700 User Guide.

* Bio-Rad® thermal cycler with Slide Chambers Dual Block Alpha Unit - For the
thermal cycling protocol, see “Bio-Rad® thermal cycler protocol” on page 127.

* Thermo Electron PX2 thermal cycler — For the thermal cycling protocol, see
“Thermo Electron PX2 thermal cycler protocol” on page 129.

Note: Contact your Applied Biosystems service representative for more
information on the thermal cyclers.

Storage

After thermal cycling, the genotyping plates can be stored at 4 °C, in the dark, for up to
72 hours.
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Guidelines for high-throughput loading

For optimal efficiency when loading large numbers (>6) of genotyping plates, follow
the guidelines below.

Before you begin loading

If possible, obtain a tip block for each genotyping plate you will load during the
high-throughput loading session.

Be sure that all the tip blocks are clean and dry, then stack the tip blocks next to
the AutoLoader. For cleaning procedures, see “OpenArray® AutoLoader and
accessories” on page 112.

Fill all TagMan OpenArray Genotyping Cases with immersion fluid, then place
the cases in a vertical slide rack.

Insert all of the genotyping plates into plate holders, then stack the plate holders
to one side.

Load the tip blocks with DNA samples. Be sure that the tips are filled to 1 mm
above the bottom edge of the tip block and that there are no air bubbles.

During and after loading
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To help avoid mistakes when entering sample information (page 68), run the
genotyping plates in the AutoLoader in alphanumeric order (per the genotyping
plate serial number).

Seal the TagMan OpenArray Genotyping Cases as time permits. You can:
— Seal all the cases at once, after the loading session is completed.

— Seal the cases in batches, while other genotyping plates are being loaded.

IMPORTANT! To avoid evaporation, you must insert the genotyping plate into a
case and cover it with immersion fluid immediately after loading. However, the
cases can be left unsealed for up to 8 hours.

Use a carrying case to transport several loaded genotyping plates from the case
sealing station to the thermal cycler, and from the thermal cycler to the
OpenArray® instrument.

After loading is complete, you can use a large bin to clean several tip blocks at a
time. For cleaning procedures, see “OpenArray® AutoLoader and accessories” on
page 112.
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Perform Imaging

This chapter covers:

Aboutthedatafiles ......... ... .. . i i 64
Setupthesoftware. ............. . 66
Enter sample information . ......... ... ... i 68
Performimaging.......... ... .. 80

In this chapter, you set up the OpenArray® SNP Genotyping Analysis Software to
prepare for imaging, then perform an imaging run on the loaded TagMan®
OpenArray® Genotyping Plates.

Chapter 4, Perform Imaging

1. Set up the OpenArray® SNP Genotyping Analysis Software.

2. Enter sample information in the OpenArray software.

3. Place the loaded TagMan® OpenArray® Genotyping Plates in the OpenArray® instrument,
then perform an imaging run.
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About the data files

The OpenArray® SNP Genotyping Analysis Software uses four types of data files:
» TagMan® OpenArray® Genotyping Plate setup files (*.spf) (this page)
* Project files (*.nix) (this page)
* TagMan® OpenArray® Genotyping Plate data files (*.spd) (page 65)

e Sample information files (*.csv) (page 65)

TagMan® OpenArray® Genotyping Plate setup files (*.spf)

Project files (*.nix)

64

When you order one or more TagMan® OpenArray® Genotyping Plates, a CD is
shipped with your order. The CD includes one plate setup file (*.spf) for each
genotyping plate in your order. Each plate setup file contains information for its
corresponding genotyping plate, such as:

e AssayID

* Reporter 1 and 2 sequences

* Gene symbol and name

* Location of each assay in the genotyping plate

Note: The OpenArray software uses the *.spf file to populate the columns in the
Assays pane. For more information, see “View data in the Assays pane” on page 83.

Each plate setup file is named with the serial number of its corresponding genotyping
plate. For example, the plate setup file for a genotyping plate with the serial number
ABCO01 is named:

e ABCO01.spf

You must copy the plate setup files (*.spf) to your computer (page 66). Before the
OpenArray® instrument can image a genotyping plate, the OpenArray software must
access the plate’s corresponding *.spf file.

Project files (*.nix) are the files you view and modify in the OpenArray software. A
project file allows you to combine, edit, and save changes to run data from up to 50
plate data files (*.spd).

Project files contain:

* Run data - When you image genotyping plates, the run data is automatically
saved to a plate data file (*.spd), then copied to the currently open project file
(*.nix).

* Modifications made to the data — Within a single project file, you can overlay,
view, and edit cluster plots from multiple plate data files (as described in
Chapter 5).
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About the data files

To save modifications made to the data, you must save the project file (use the
File » Save or File » Save As function). Otherwise, all your changes are lost. Project file
names and save locations are user-defined.

IMPORTANT! The software copies the run data from the plate data file to the project file.
The files are not linked; that is, modifications you save to the project file (*.nix) are not
saved to the corresponding plate data file (*.spd).

TagMan® OpenArray® Genotyping Plate data files (*.spd)

A plate data file (*.spd) contains run data for a single genotyping plate. Plate data files
are generated by the OpenArray software during imaging.

The software automatically names plate data files with the genotyping plate serial
number. For example, the plate data file for a genotyping plate with the serial number
ABCO01 is named:

e ABCO01.spd
By default, the software saves the *.spd files to the following location:
<drive>:\images\<run date><run number>
where:

<drive> is the computer drive on which the OpenArray software is installed. The
default installation drive is the C: drive.

<run date> is the date the run was performed.

<run number> is the chronological run number.

For example, data for the third run on June 15, 2008, is saved to:
e C:\images\06-15-08\3

After a run is completed, you can change the *.spd file name and or save the *.spd file to
a different location.

Sample information files (*.csv)

The OpenArray software uses comma-delimited files (*.csv) to import and export
sample information:

e Import — Applied Biosystems recommends that you create sample information
files (*.csv) to track your DNA samples, per the procedures on page 25. Prior to
imaging the genotyping plates, you can import the sample information into the
OpenArray software. See “Import sample information from a *.csv file” on page
71.

e Export — After an imaging run, you can export data from your project. See
“Export *.csv files” on page 106.
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Set up the software

Set up the OpenArray software for each genotyping plate to be included in the
imaging run:

Start the OpenArray® instrument and software (this page)
Copy the plate setup file (*.spf) to your computer (this page)
Enter the TagMan® OpenArray® Genotyping Plate serial number (page 67)

Enter sample information (page 68)

Start the OpenArray® instrument and software

1.

Power on the OpenArray® instrument. The power switch is on the front-right of
the instrument.

On the computer, start the OpenArray software:
¢ Double-click the software icon @
or

* Select Start » All Programs » BioTrove » OpenArray® SNP Genotyping
Analysis Software <version number> » OpenArray® SNP Genotyping
Analysis Software.

The software opens a new (empty) project file (*.nix).

Wait for the system to fully boot up. When the system is ready, the system
indicator circle turns green and Idle appears in the software status bar (at the
bottom of the window). This may take a few minutes.

Copy the plate setup file (*.spf) to your computer

1.

2.

66

Locate the CD that was shipped with your TagMan Open Array plate.

Insert the CD into the computer, then open the folder that contains the plate setup
files (*.spf).

Note: If you ordered more than one genotyping plate, the folder contains a plate
setup file for each plate.

Copy the plate setup files to the PLATEFILES folder:
<drive>:\Program Files\BioTrove\PLATEFILES

where <drive> is the computer drive on which the OpenArray software is
installed. The default installation drive is the C: drive.
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Enter the TagMan® OpenArray® Genotyping Plate serial number

In this procedure, you enter the serial number for each genotyping plate to be imaged
(1 to 3 plates can be imaged per run). The OpenArray software uses the serial numbers
to access the appropriate plate setup files (*.spf). During imaging, the software uses
information in the plate setup files to populate the Assays pane in the project file
(*.nix).

Note: Forinformation on the Assays pane, see “View data in the Assays pane” on page
83.

To enter genotyping plate serial numbers:

1. In the OpenArray software, open a project file (*.nix). You can open:

* A new project file — Use the project file automatically opened at startup, or
select File » New.

* An existing project file (containing data from previous runs) — Select
File » Open, browse to and open a project file.

2. Click Image to open the Input Plate Serial Numbers dialog box:

Position 1

e

Position 2

Flate Serial Number Edit.. Locate File.

rPosition 3

Flate Serial Nurmber Edit Locate File

Cancel

3. In the Position 1 pane, click Locate File.

Note: The positions indicate where the genotyping plate will be placed in the
OpenArray® instrument (page 79). If you are running fewer than three
genotyping plates, Applied Biosystems recommends the following: For one plate,
use Position 1; for two plates, use Positions 1 and 2.
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4. Browse to and open the plate setup file (*.spf) that corresponds to the genotyping
plate. The software automatically displays the serial number in the Plate Serial
Number field.

rPasition 1
Plate Serial Mumber  [ABCO1 Edit Locate File.

Pasiton2
Plate Serisl Number Edit

rPasition 3

osition
Plate Serial Mumber Edit Locate File.

Cancel Image

5. Repeat steps 3. and 4. for Positions 2 and 3. If you are loading fewer than three
genotyping plates, leave the Plate Serial Number fields for these positions empty.

Leave the Input Plate Serial Numbers dialog box open, then proceed to “Enter sample
information” on page 68. (If you close the dialog box, the information you have entered
will be lost.)

Note: You can also enter the serial number by typing it in or by scanning the barcode
located on the genotyping plate package. To enter the serial number by typing or
scanning, the *.spf file must be located in the PLATEFILES directory (see “Copy the
plate setup file (*.spf) to your computer” on page 66). Otherwise, the software will not
be able to automatically locate the *.spf file.

Enter sample information

68

In this procedure, you enter information about:

¢ Each sample plate that was used to transfer DNA samples to the genotyping
plates in the current imaging run.

e Each DNA sample that was transferred to the genotyping plate.

This information allows you to track the sample plates, and map the sample plate areas
to each genotyping plate.

You can:

Manually enter sample information (page 69)

¢ Import sample information from a *.csv file (page 71)

(Optional) Add columns (page 74)

(Optional) Delete user-created columns (page 76)
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Manually enter 1. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click Edit to
sample information open the Sample Information dialog box.

£ Input Plate Serial Numbers

rPasition 1

Plate Serial Mumber  [ABCO1 Edit Locate File.

rPasition 2

Plate Serial Mumber  [ABC02 Edit Locate File.

rPasition 3

Plate Serial Mumber  [B.JS84 Edit

2. For each load number:

a. In the Sample Plate Serial Number field, enter the unique identifier for each
sample plate.

Note: The unique identifier is the one you created when you prepared the
sample plates. See “Set up the sample plates” on page 33.

b. From the Plate Area # dropdown menu, select the 12-well x 4-well area of the
sample plate that the samples were transferred from.

The software displays 1
to 3 load numbers (Load
1, Load 2, and Load 3),
depending on the —
format of the genotyping
plate.

ample Information For BJS84

et
002843 1 .
EEE 2 = ':‘
222895 3

Tir

i

Li
L
L

|

L]
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3. Enter sample information for each sample, per the procedure below.

Note: You cannot enter or edit information in the following columns: Load
Number, Plate ID, and Address. If you want to add new columns, see page 74.

If you want to... Then, in the Sample Information dialog box...

Enter sample Edit the desired fields in the Selected Samples pane:
information for all loads

at one time (1to 3
loads) 2. Enter the appropriate information.

1. Double-click inside the field to activate it.

Plate Layout

PRI <2655

Selected Samples
Load Number | Plate ID Address Sample|D | Dilution Description &

082843 21418 1.00 Treatment C9
202643 45845 1.00 Treatment C.
822843 31837 1.00 Treatment C.
202843 74220 1.00 Treatment C.
622843 68690 1.00 Treatment D1
202643 74472 1.00 Treatment D2
882843 65488 1.00 Treatmert D3
202643 56605 1.00 Treatment D4
882843 38688 1.00 Treatment DS
202643 83074 1.00 Treatmert D6
822843 15788 1.00 Treatment D7
202643 48608 Treatment D8
652843 50855 Treatmert D3
202643 38548 Treatment D.
082843 45147 Treatment D.
202643 22712 Treatment D.
622893

202683

622893

202693

Enter sample
information for each
load separately

2. Edit the desired fields in the Sample Plate Well Contents pane:
a. Double-click inside the field to activate it.
b. Enter the appropriate information.

Sample ID Description | &
Treatrent Al
Treatment A2
Treatrment A3
Treatment A4
Treatment A5
Treatment AB
Treatment A7
Treatrment AB
Treatment A9
82843 Treatment A10
82843 Treatrment ATl
22843 Treatment A12

222843 Treatment B1
222843 Treatment B2 | v

3. Click OK to close the Sample Plate dialog box.

4. Repeat steps 1. through 3. above for the remaining load(s).
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4. Click OK to close the Sample Information dialog box and return to the Input Plate
Serial Numbers dialog box.

5. If you are imaging two or three genotyping plates, repeat step 1. on page 69
through step 4. (above) for the remaining plates. In step 1.

¢ For the second plate, click Edit next to Position 2.
¢ For the third plate, click Edit next to Position 3.

Pasition 1
Plate Serial Number  [4BCO1 Edit Lacate File
Pasition 2
Plate Serial Number  [ABCIZ Edit Lacate File
Pasition
Plate Serial Number  [BJS84 Edit
Cancel Image

Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform
imaging” on page 78. (If you close the dialog box, the information you have entered

will be lost.)
Import sample 1. If you have not done so already, create a *.csv file per one of the following
information from a procedures:
*.csv file e “Use a spreadsheet or simple text program” on page 30

e “Export sample information from an existing *.nix file” on page 30

2. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click Edit to
open the Sample Information dialog box.

Posiion 1
Flate Serial Number  [ABCO1 Edit Locats File
Positon 2
Plate Serial Number  [ABC02 Edit Locats File
Pasitan 3
Plate Serisl Number  [BJS84 Edit
Cancel Image
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3. For each load number:

a. In the Sample Plate Serial Number field, enter the unique identifier for each

sample plate.

Note: The unique identifier is the one you created when you prepared the
sample plates. See “Set up the sample plates” on page 33.

. From the Plate Area # dropdown menu, select the 12-well x 4-well area of the

sample plate that the samples were transferred from.

:Sample Information For Generic_64_1

The software displays 1
to 3 load numbers (Load
1, Load 2, and Load 3),
depending on the

format of the genotyping

plate. #iSample Information For BJS84

Tip —_—

Number Flate

EET (Y|
[aa2893 2 ':‘
[aa7895 3 ’7

«E

|

|
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4. Import the sample information, per the procedure below.

If you want to...

Then, in the Sample Information dialog box...

Import the sample
information for all loads
at one time (1to 3
loads)

Import the sample
information for each
load separately

TagMan® OpenArray® Genotyping Getting Started Guide

1. Click Import to open the Import Sample Plates dialog box.

ample Information For BJS84

Selected Samples
Load Number | Plate ID Address Sample!D | Dilution Description &

652843 ca 21418 1.00 Treatmert C3
202643 cio 45845 1.00 Treatment C.
282843 ci 31837 1.00 Treatment C.
202643 74220 1.00 Treatment C.
622843 68690 1.00 Treatment D1
202843 74472 1.00 Treatment D2
682843 65488 1.00 Treatmert D3
202643 56605 1.00 Treatment D4
82843 38688 1.00 Treatment D5
202643 83074 1.00 Treatment D6
882843 15788 1.00 Treatment D7
202643 48608 1.00 Treatmert D8
622843 50865 1.00 Treatment D3
202843 38549 1.00 Treatment D.
652843 45147 1.00 Treatmert D.
202643 22712 1.00 Treatment D.
282893 1.00

202693 1.00

622893 1.00

202683 1.00

2. Browse to and open the *.csv file to import. The sample information appears in the Selected
Samples pane.

IMPORTANT! Be sure to select a *.csv file that contains sample information for all of the
required loads.

3. Edit the sample information in each row, as needed.

1. Click Bl next to appropriate load number to open the Sample Plate dialog box.

mber

Dilution Description | &
Treatment A2
Treatment A3
Treatment A4
Treatment AS
Treatment AB
Treatment A7
Treatment A8
Treatment A3
Treatment A10
Treatment A11
Treatment A12
Treatment B1
Treatment B2 | v

3. Browse to and open the *.csv file to import. The sample information appears in the Sample

Plate Well Contents pane.

4. Edit the sample information in each row, as needed.
5. Click OK to close the Sample Plate dialog box.

6. Repeat steps 1. through 5. above for the remaining load(s).
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5. Click OK to close the Sample Information dialog box and return to the Input Plate
Serial Numbers dialog box.

6. If you are imaging two or three genotyping plates, repeat step 1. on page 71
through 5.(above) for the remaining plates. In step 1.:

* For the second plate, click Edit next to Position 2.
¢ For the third plate, click Edit next to Position 3.

Postion 1
Plate Serial Number — [ABCO1 Edit Locete File
Position 2
Plate Serial Number  [ABC02 Edit Locete File
rPosttion 3
Plate Serial Number  [BJS84 Edit
Cancel Image

Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform
imaging” on page 78. (If you close the dialog box, the information you have entered

will be lost.)
(Optional) Add Note: You can also add new columns after imaging is complete; see “View data in the
columns Assays pane” on page 83.

1. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click Edit to
open the Sample Information dialog box.

Pasitian 1
Plate Serial Number  [ABCO1 Edit Lacate File
Pasition 2
Plate Serial Number ABCD2 Edit Locate File.
Pasition 3
Plate Serial Number BS54 Edit
Cancel Image
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Do not use commas or periods in column names; text is case-sensitive. After
imaging, in the Samples pane of the OpenArray software main window,
Samplelnfo.Properties. is prefixed to all new column names to differentiate them
from the standard columns. If you assign a standard column name to a new
column, the software will automatically rename it. For a description of the
standard columns, see page 84.

2. Add new columns, per the procedure below.

If you want to... Then, in the Sample Information dialog box...

Add new columns forall | 1. Click Edit Columns to open the Columns For Sample Plates dialog box.
loads at one time (1to 3

loads) 2. Click Add, select New Field, enter the new column name, then click OK.
oads

ample Information For BJS84

Add new columns for 1. Click Bl next to the appropriate load number to open the Sample Plate dialog box.
each load separately Frooreat

2. Click Edit Columns to open the Columns For Sample Plate dialog box.

3. Click Add, select New Field, enter the new column name, then click OK.

mple Plate

4. Click OK to close the Sample Plate dialog box.

5. Repeat steps 1. through 4. above for the remaining load(s).
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3. Click OK to close the Sample Information dialog box and return to the Input Plate
Serial Numbers dialog box.

4. 1If you are imaging two or three genotyping plates, repeat step 1. on page 74
through step 3. (above) for the remaining plates. In step 1.:

* For the second plate, click Edit next to Position 2.
¢ For the third plate, click Edit next to Position 3.

Postion 1
Plate Serial Number — [ABCO1 Edit Locete File
Position 2
Plate Serial Number  [ABC02 Edit Locete File
rPosttion 3
Plate Serial Number  [BJS84 Edit
Cancel Image

Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform
imaging” on page 78. (If you close the dialog box, the information you have entered

will be lost.)
(Optional) Delete Note: You cannot delete any columns created by the software (standard columns). For
user-created a description of the standard columns, see page 84.

columns .
1. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click Edit to

open the Sample Information dialog box.

Posiion 1
Flate Serial Number  [ABCO1 Edit Locats File
Positon 2
Plate Serial Number  [ABC02 Edit Locats File
Pasitan 3
Plate Serisl Number  [BJS84 Edit
Cancel Image
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2. Delete user-created columns, per the procedure below.

If you want to... Then, in the Sample Information dialog box...

Delete columns for all 1. Click Edit Columns to open the Columns For Sample Plate dialog box.
loads at one time (1to 3
loads)

2. Select the column name, click Delete, then click OK.

28051 1.00
82158

Delete columns for
each load separately

2. Click Edit Columns to open the Columns For Sample Plate dialog box.
3. Select the column name, click Delete, then click OK.

mple Plate

Columns For Sample Plate: "* @1

4. Click OK to close the Sample Plate dialog box.

5. Repeat steps 1. through 4. above for the remaining load(s).

3. Click OK to close the Sample Information dialog box and return to the Input Plate
Serial Numbers dialog box.
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4. 1If you are imaging two or three genotyping plates, repeat step 1. on page 76
through step 3. (above) for the remaining plates. In step 1.:

* For the second plate, click Edit next to Position 2.
¢ For the third plate, click Edit next to Position 3.

(Pastion 1
Plate Serial Number — [ABCO1 Edit Locete File
Position 2
Plate Serial Number — [ABC02 Edit Locete File
(Position 3
Plate Serial Number  [BJS64 Edit
Cancel Image

Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform
imaging” on page 78. (If you close the dialog box, the information you have entered
will be lost.)

Perform imaging

During imaging, the OpenArray® instrument senses and records the amount of
fluorescence in each through-hole of the genotyping plates. The run data are
automatically saved to the plate data file (*.spd).

Workflow:

e Place the plates into the OpenArray® instrument (this page)
* Perform imaging (page 80)

OpenArray® instrument commands

The table below is a summary of OpenArray software commands that you can use to
control the OpenArray® instrument.

Command Description

Stop Imaging To stop imaging at any time:

In the OpenArray software, select Actions » Stop Imaging. A message
appears asking if you want to save the collected data.

Click Yes to save the incomplete plate data file (*.spd).

OrClick No to continue imaging.

Interior Light To turn on the light inside the instrument, select Actions » Interior Light.
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Place the plates into the OpenArray® instrument

1. Open the OpenArray® instrument door and lid, then place the genotyping
plate(s) into the instrument.

2. Be sure that:

¢ The plate position in the instrument matches the position you entered in the
software (see step 3. on page 67):

— TPosition 1 is at the back of the instrument
— TPosition 2 is in the middle
— Position 3 is at the front (closest to the door)

* The barcode is facing up and to the right, and the plate is flush with the right
and back edges.

Barcodes

C

Note: If the plates are not positioned correctly, your data results will be adversely
affected.

x
Front of the OpenArray® instrument

3. Close the OpenArray® instrument lid and door.
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Perform imaging

80

. In the Input Plate Serial Numbers dialog box, click Image. During the imaging

run, note that:

* On the OpenArray® instrument, a blue indicator light on the front of the
instrument is on.

¢ In the OpenArray software, the system indicator circle turns blue and

Imaging OpenArrays appears in the software status bar (at the bottom of the
window).

IMPORTANT! Do not open the OpenArray® instrument door during the imaging
run. The run is complete when: (1) The blue indicator light on the instrument is
off; and (2) In the software, the system indicator circle turns green and data
appears.

. When the run is complete, save the project file (*.nix):

a. Select File » Save or File » Save As to open a save dialog box.
b. Browse to a save location, then enter a file name.

Note: Project file names and save locations are user-defined. Project file
names can be up to 255 characters in length, including spaces and non-
alphanumeric characters. The following characters are not allowed:
\/:*27 <>,

c. Click Save.

. Open the instrument door, then remove the genotyping plates.

Note: Applied Biosystems recommends that you temporarily save the
genotyping plates until you have reviewed the data. If you store the plates in the
dark at 4 °C, you can re-image the plates for up to 5 days.

. To image more genotyping plates, open the appropriate project file (*.nix). You

can:
¢ Use the currently opened project file.
* Open a new project file — Select File » New.

* Open an existing project file (containing data from previous runs) — Select
File » Open, then browse to and open a project file.

Note: If needed, you can regroup data later. See “(Optional) Modify project files”
on page 102.
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Analyze the Run Data

This chapter covers:

View theresults. ... ... 82
(Optional) Modify clustering parameters...................coooviiiioo.... 92
(Optional) Modify projectfiles........... ... ..o i i it 102
(Optional) Publishdata............. ... ... ..o o i i ool 105
(Optional) Perform downstream analysis................................ 108

In this chapter, you view the data from the imaging run (performed in Chapter 4) in a
project file (*.nix). If needed, you can modify the clustering parameters or modify the
project file. This chapter also explains how to publish data and how to export data for
downstream analysis using the Applied Biosystems AutoCaller'" Software.

Chapter 5, Analyze the Run Data

. View the results.

. (Optional] Modify clustering parameters.

1
2
3. (Optional) Modify project files (*.nix).
4. (Optional) Publish data.

5

. (Optional) Perform downstream analysis using the AutoCaller™ Software.
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View the results

View the results

After an imaging run, the OpenArray® SNP Genotyping Analysis Software
automatically calls the genotypes for each TagMan® OpenArray® Genotyping Plate in
the run. To view the results of the automatic analysis:

Open a project file (this page)

View data in the Assays pane (page 83)
View data in the Scatter Plot (page 85)
View data in the Samples pane (page 88)

If the automatic calls are not suitable for your experiment, see “(Optional) Modify
clustering parameters” on page 92.

Open a project file

1.

In the OpenArray software, select File » Open, then browse to and open the
appropriate project file (*.nix).

Note: After a run, the OpenArray software automatically displays the results for the
current run.

2. In the Assays pane, select the assay ID to view. The data appear in the Samples
pane and in the Scatter Plot.

B File Edit Actions Tools Help
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3. To view data for a specific through-hole, select the:
¢ Datapoint in the Scatter Plot (page 85)
or
Through-hole address in the Samples pane (page 88)

Through-holes are identified in the Samples pane by an address. The address
is assigned based on the through-hole location in the genotyping plate.

The genotyping plate address
appears in this column.

Opendrray ... | Sample 1D | Genotype . Consensus ... | Replicate ID | Address rs
BlA74.0.0 Alal

BIAT4 W WY BlA74.1.0 Azal

BIAT4 W WY BlAT4.2.0 A3al

ElA74 W W BlA74.53.0 Adal

BlAT4 W WO BlA74.4.0 ASal

ElAT4 W WY BIAT4.5.0 ABal

4. (Optional) Enter the allele nucleotide sequences detected by each assay:

a. In the Assays pane, click in the appropriate sequence column:
Reporter 1 Sequence or Reporter 2 Sequence.

b. Enter the appropriate letter for the reporter dye: F (FAM™ dye), V (VIC®
dye), or N (non-specific).

WIC SEQUENCE Fak SEQUENCE | Your Headi Minar Allele -

73 0445 F

73212079 W F 0 [
73211052 N4 F 1]

73212085 W F a

73212065 W F 1]

73212061 W F a

73212071 W F 1]

73212094 W F a

73211057 k4 F 1]

73212080 W F a -
4 4

View data in the Assays pane
Each row in the Assays pane represents a specific assay.

1. To select individual assays, click the row you want to view.

In the Scatter Plot, the software displays a black circle around the datapoints for
the assays you selected. (Each datapoint in the Scatter Plot represents a specific
through-hole.)

2. To arrange rows in ascending or descending order, click a column heading.
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Assays pane column
descriptions

Column name

Column description

Study Name

User-defined name for the sales order. At the time of purchase,
you enter a study name for your order.

Order Number

Assay ID

Customer sales order number

Unique identifier for the assay

Reporter 1 Sequence

The nucleotide sequence of reporter 1

Reporter 2 Sequence

The nucleotide sequence of reporter 2

Gene Symbol

Gene Name

LocusLink symbol for the associated gene

LocusLink gene name

Chromosome

Chromosome on which the gene or SNP is found

NCBI SNP Reference

Reference ID from the NCBI-dbSNP database

Cytogenetic Band

Chromosomal band location of gene.

If the cytogenetic band is not available, the chromosome number
is listed instead

SNP Type

Type of SNP, based on Celera Assembly: Acceptor Splice Site,
Donor Splice Site, Intergenic/Unknown, Intron, Mis-sense
Mutation, Nonsense Mutation, Putative UTR 5ESilent Mutation,
UTR 3, UTRY

84
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Chapter 5 Analyze the Run Data
View the results

Each datapoint in the Scatter Plot represents a specific through-hole.

1.

C 3188989 10
C 8376184 10
C 3197300 10
C 9077581 20
C 29882391 10
C 34511515 10
C 3222272 10
C 940288 10
C 1240851 20
4

To select:

¢ Individual through-holes — Click the datapoint you want to view.
¢ Multiple through-holes — Press the CTRL key while clicking the datapoints

you want to view.

5

In the Samples pane, the software highlights the rows for the through-holes
you selected. (Each row in the Samples pane represents a specific through-
hole.)

20%
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BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4
BIAT4

2. To group datapoints by their angle about a clustering axis, select the Point tab.
Clusters are described by lines between their clustering axis and automatically

OpenArray | Sample ID_| Genotype

Cansensus

No Call
v

Vv
Vv
No Call
Vv
Vv
VF
Vv
Vv
Vv
Vv
Vv
Vv

v
No Call
v

Replicate 1D Address - . B . .
R |5 .
Buubl e =) Click the datapoint in the .
BIA74.1.0 A2al . (%Y
BIA74.2.0 Adal
Ba7420 JaSel Scatter Plot. The software .
BIA74.4.0 Abal “
B highlights the :
BIA74.6.0 ATal H H
e corresponding row in the '
BIA74.8.0 Afal
Samples pane.
BIA74.10.0 Allal
BIA74.11.0 Al2al
BIA74.12.0 Blal o
BIA74.13.0 B2al
BIA74.14.0 B3al .
BIA74.15.0 B4al < &
BIA74.16.0 B5al .
BIA74.17.0 BBal 2603
BIA74.18.0 B7al
BIA74.18.0 BBal
BIAT74.20.0 B3al
BIA74210 _|B10al 761
BIA74.22.0 Bl1al
BIAT74.23.0 B12al
BIAT74.24.0 Clal
BIAT74.25.0 C2al
BIA74.26.0  |C3al ® 1515 1974 2434 293 3353 3812 4212 4731
BIA74.27.0 C4al VIC Intensity

determined cluster centers.

FAM Intensity
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3. To group datapoints by their inclusion in a cluster, select the Draw tab. Inclusion
is represented by an ellipse or hand-drawn shape.

Scatter Plot for C__29086771_20

FAM Intensity

il

(/ il
6817 =

5974

5132 ( - -" =‘: // ) /
w7 .
{ I : o

4289 \ o X
R P

3446

2603

1761

1515 1974 2434 2893 3353 3812 4212 4731 5191
VIC Intensity

4. To change the datapoint color display, in the Point or Draw tab:

¢ Select the Colors checkbox to display colors for the datapoints by genotype.
For a description of the colors, see page 87.

* Deselect the Colors checkbox to display all datapoints in gray.

5. To zoom in or out:

® Zoom in - Right-click in the corner of the area you want to view, drag
diagonally across the area, then release the mouse. The selected area will be
enlarged.

* Zoom out — Right-click any where in the Scatter Plot. The entire plot
reappears.
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View the results

Datapoint color descriptions

The color of each datapoint in the Scatter Plot indicates the genotype calls made by the

software.
Color Color description

Blue FAM™ dye homozygous

Green FAM™ and VIC® dye heterozygous

Red VIC® dye homozygous

Orange Outlier
To set outliers, see page 93.

Cyan Don’t Call
To set Don't Call samples, see page 99.

Black No Call
No Call samples are set by the software. The software sets a sample as No
Call if its datapoint is outside the range of all clusters or within the range
of two or more clusters.
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View data in the Samples pane

Each row in the Samples pane represents a specific through-hole.

1. To select:
¢ Individual through-holes — Click the row you want to view.
* Multiple through-holes, nonadjacent — Press and hold the CTRL key, then
click the rows you want to view.
* Multiple through-holes, adjacent — Press the SHIFT key, then click the first
and last rows of the block you want to view.
In the Scatter Plot, the software displays a black circle around the datapoints for
the through-holes you selected. (Each datapoint in the Scatter Plot represents a
specific through-hole.)
C 3188989 10 2 20X 250 u BO1 — FAM Intensity
c 8376164 10 3 20X 280 u caot1 8503 [%
c 3197300 10 4 20X 250 u D01
c 9077561 20 5 20X 280 u EO01
C 29882391 10 5] 20X 250 u FO1
C 34511515 10 7 20X 280 u Go1 7660
c 3222272 10 8 20X 250 u HO1
c 940286 10 El 20X 280 u AD2
c 1240851 20 10 20X 250 u B0Z2 w
<« B B LH 6817 .
OpenArray ... | Sample ID_| Genotype ... | Consensus Address a CUCk a row in the Samples
o o o — pane. The software circles the
s T Brico el corresponding datapoint in the -
BIAT4 VY VY BlA74.4.0 Abal “
BIAT4 Vv vy BIATA50  ABal 1| Scatter Plot. R
BIAT4 VY VY BlA74.6.0 ATal .
BIAT4 VY VY BI&74.7.0 ABal h
BIAT4 VF VF BlA74.8.0 Adal
BIAT4 VY VY BI&A74.9.0 AlDal
BIAT4 VF VF BIA74.10.0 Allal
BIAT4 No Call No Call BIA74.11.0 Al2al /
BIAT4 VF VF BIA74.12.0 Blal 3046
BIAT4 VY VY BIA74.13.0 B2a1l
BIAT4 VY VY BIA74.14.0 B3al *
mit Sl i b et
BIAT4 VY VY BIA74.17.0 BBal
BIAT4 VF VF BIA74.18.0 B7al
BIAT4 VY VY BIA74.19.0 B8al
BIAT4 VY VY BIA74.20.0 B9a1
BIAT4 2% 2% BIA74.21.0 | B10al 1761
BIAT4 VY VY BIA74.22.0 Bi1al
BIAT4 VY VY BIA74.23.0 B12al
BIAT4 VY VY BIA74.24.0 Clal
g:i;: zquaH zquaH g:i;: ;:E gi: ® 1515 1974 2434 2893 } 3353 3812 42712 4731 5191
BTs Ve Ve BAT4270 Gl Ve ntensiy

2. To arrange rows in ascending or descending order, click a column heading.

To arrange rows in ascending or
descending order, click a column
heading.

3.

88

OpenArray ... | Sample ID Genotype ... | Consensus ... | Replicate I Address Fs
BIAT4 W W AZal

BIAT4 WF W F El&74.10.0 Allal

BIAT4 Mo Call Mo Call Bl474.11.0 Al2al

BIAT4 W W F Bl&74.12.0 Blal

BEIAT4 WY W El&74.13.0 BZal

RIAT4 AT W RlAT74 141 RAal

To add new columns, use either the Sample Information dialog box or the Sample
Plate dialog box, as described in the table below.
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Chapter 5 Analyze the Run Data 5
View data in the Samples pane

Do not use commas or periods in column names; text is case-sensitive. In the
Samples pane, Samplelnfo.Properties. is prefixed to all new column names to
differentiate them from the standard columns. If you assign a standard column
name to a new column, the software will automatically rename it. For a
description of the standard columns, see page 90.

Procedure

Sample Information
dialog box

1. Click Edit to open the Samples Information dialog box.
2. Click Edit Columns to open the Columns For Sample Plate dialog box.

3. Click Add, select New Field, enter the new column name, then click OK.

Sample Plate dialog box

1. Click Edit to open the Samples Information dialog box.
2. Click [l next to the appropriate load number to open the Sample Plate dialog box.

nber Plate Area #

3. Click Edit Columns to open the Columns For Sample Plate dialog box.
4. Click Add, select New Field, enter the new column name, then click OK.

mple Plate

Columns For Sample Plate: "™ @1
Add
s
Delee

=1
Cancel

5. Click OK to close the Sample Plate dialog box.
6. Repeat steps 1 through 5 for the remaining load(s).
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Column name

OpenArray Serial
Number

Column description

An alphanumeric code (for example, ABC01) for the TagMan®
OpenArray® Genotyping Plate. A user scans (via the barcode) or
enters the serial number in the software (see step 3. on page 67).

Sample ID

The sample identification (user-defined). A user enters the sample
ID in the software (see “Enter sample information” on page 68). If a
sample ID was not entered, fields in this column are blank.

Genotype String

Consensus Genotype
String

The genotype call made for the sample by the software or by a user:
VV = VIC® dye homozygote

VF = Heterozygote

FF = FAM™ dye homozygote

No Call or Don’t Call = No genotype is called for the sample
Outlier = The sample is set as an outlier

A, C G, N, or T = Allele information

The calculated genotype result for all assay replicates.

Replicate ID

Reserved for future use.

Address

The location of the assay on the TagMan® OpenArray® Genotyping
Plate (for example, A1a1).

Distance To Cluster
Center

The distance between the datapoint and the appropriate genotyping
cluster line.

Confidence

A measurement between 0 and 1. Larger values indicate close
proximity to the cluster line compared with other datapoints in the
cluster.

Distance To Nearest
Cluster In STDs

Distance To Next
Nearest Cluster In
STDs

Through-Hole Index

The distance between a datapoint and the nearest cluster line,
expressed as standard deviation units. The standard deviation is
calculated using all datapoints in the relevant cluster.

The distance between a datapoint and the next nearest cluster line,
expressed as standard deviation units. The standard deviation is
calculated using all datapoints in the relevant cluster.

The identification number of the through-hole in which the assay
was cycled and imaged.

VIC, FAM

The measurement of indicated dye fluorescence detected by the
OpenArray® instrument.

Sample Plate Serial
Number

An alphanumeric code for the TagMan® OpenArray® 384-Well
Sample Plate (user-defined). A user enters the serial number in the
software (see “Enter sample information” on page 68).

Sample Address

The well in the TagMan® OpenArray® 384-Well Sample Plate from
which the sample was transferred.
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Column name Column description

Sample Dilution The sample concentration (user-defined). A user enters the sample
dilution in the software (see “Enter sample information” on page
68). If a sample dilution was not entered, fields in this column are
blank.

Sample Description A description of the sample (user-defined). A user enters the
sample description in the software (see “Enter sample information”
on page 68). If a sample description was not entered, fields in this
column are blank.

Samplelnfo.Propertie | Indicates a new column added by a user. All user-defined columns
s are prefixed with Samplelnfo.Properties.
<heading>

where: <heading> is
user-defined.

TagMan® OpenArray® Genotyping Getting Started Guide 91



5 Chapter 5 Analyze the Run Data
(Optional] Modify clustering parameters

(Optional) Modify clustering parameters

After an imaging run, the OpenArray software automatically calls genotypes. If the
automatic calls are not suitable for your experiment, you can modify the clustering
parameters as follows:

* Set outliers (page 93)

¢ Adjust genotyping clusters (page 94)

¢ Adjust stringency (page 97)

* Adjust tolerance (page 98)

* Set Don't Call samples (page 99)

e Exclude genotyping clusters from analysis (page 99)

¢ Draw genotyping clusters (page 101)

IMPORTANT! Modifications to clustering parameters are made only to the assay you
are viewing, not to the entire project. To change the default settings for the entire
project, see “Set project parameters” on page 103.

About the Auto functions

There are three Auto functions in the OpenArray software:

* Auto button in the Samples pane — The software re-calls a sample that a user has
labeled Don't Call or Outlier, per the current settings. To use this Auto function,
select the sample, then click Auto in the Samples pane.

* Auto button in the Draw or Point tab — The software determines genotype
calling parameters for the current assay and re-calls the genotypes (FAM, Het,
VIC, or No Call) for all samples applied to the current assay. To use this Auto
function, select the assay, then click Auto in the Draw or Point tab.

* Auto Reclassify All Assays — The software determines the genotype calling
parameters for all assays and re-calls the genotypes (FAM, Het, VIC, or No Call) for
all samples. To use this Auto function, select Action » Auto Reclassify All
Assays.

Save your changes to the project file

To save modifications made to the data, you must save the project file. If you do not
save the project file, all your changes are lost after you close the file.

IMPORTANT! The software copies the run data from the plate data file to the project file.
The files are not linked; that is, modifications you save to the project file (*.nix) are not
saved to the corresponding plate data file (*.spd).

1. Select:
* File » Save to save the changes to the current project file.

¢ File » Save As to save the changes to a new project file. The File » Save As
function allows you to perform multiple analyses of the same plate data file

(*.spd).
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2. Browse to a save location, then enter a file name.

Note: Project file names and save locations are user-defined. Project file names can be
up to 255 characters in length, including spaces and non-alphanumeric characters. The
following characters are not allowed: \ /:*? “ <> |,

3. Click Save.

Set outliers

If your data includes one or more datapoints with fluorescence that is very different
from that of most of the other datapoints, you can set them as outliers. The software
does not call outliers.

1. In the Samples pane or Scatter Plot, select the samples to set as outliers.

2. In the Samples pane, click Outlier. The software:
* Labels each selected sample as Outlier in the Samples pane.
* Removes the outliers from view in the Scatter Plot.

¢ Recalculates the clusters without the outliers.

FAM Intensity
31146

® The fluorescence of
this datapoint is
different from the
others. Select it, then
click Outlier.

23931

16715 ral|

9500

"‘ .
P
Feo

/ S - L N B
I e —

2164 3006 3848 4689 5531
VIC Intensity

3. To view the outliers, select the Outliers checkbox in the Point or Draw tab. The
outliers appear in the Scatter plot as orange datapoints.

4. To include an outlier back in the analysis:
a. Select the sample.

b. Click Auto in the Samples pane.
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Adjust genotyping clusters

Use the Point and Draw tab tools to adjust genotyping clusters. You can:

* Drag and drop to move the clusters and exclusion bars (this page)

e Use the Auto-Classification Wizard to move the clusters and exclusion bars (this
page)
* Modify the cluster shapes (page 96)

Drag and drop 1. In the OpenArray software, select the Point tab.

2. Drag and drop the:

e (Cluster center

e |

. _Ra.'

e e

‘ . / ." Cluster center:

_ Cluster center: ' After
Before ‘ ‘
Or
e Exclusion bar
e } } } e Exclusion bar:
Exclusion bar: e After
2603 Before 2603
\
Auto-Classification 1. In the OpenArray software, select the Point tab.
Wizard
2. Click Set.
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3. At the prompt, exclude the datapoints close to the axis: Select a datapoint where
all the datapoints with less fluorescence will be marked No Call. For example, you
may want to exclude no template controls (NTCs).

T roimt WD’EW‘

Click to . Follow the prompt to 2603 /

G exclude the datapoints

points close .

to the axis. close to the axis.

1761 < - *
1515 1974

. Click
Set. |

4. At the prompt, set the clustering axis: Click where all the cluster lines appear to
intersect. Typically, the cluster lines intersect near the origin.

Paint } Draw |

fSrryan . Follow the prompt to set 0

iz i the clustering axis.
-ing axis.

1761 * M

3 ® 1515
Lines

5. At the prompts, click where you want to set the new:
a. FAM dye cluster center

Paint ‘Draw ]

Click to set
the FAM
cluster
center.

b. Heterozygote cluster center

Point 1 Draw ‘

Click to set
the Hetero
-zygote
cluster
center.

c. VIC dye cluster center.

Paint ‘Draw ]

Click to set
the VIC

cluster
center.
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6. To make further changes, repeat steps 1. through 5..

7. Click Apply to apply the changes.

Modify the cluster You can rotate, resize, reshape, and move the ellipses drawn around each genotyping
shapes cluster. These adjustments change the genotype call for datapoints that were outside
and are now inside the cluster and visa-versa.

To modify the cluster shapes:

1. In the OpenArray software, select the Draw tab. The software automatically
draws ellipses for each genotype.

Note: The software does not call datapoints that are outside a cluster area or are within
more than one cluster area.

2. Select the cluster you want to modify. You can:
e Select , then click the cluster.
Or
¢ Select Tools » Pointer, then click the cluster.
The software highlights the selected clusters as shown.

3. To rotate the cluster: Click and drag the green handle in the direction you want to
rotate the cluster.

Click and drag
the green circle.

Cluster: Before

Cluster: After
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4. To resize the cluster: Click and drag the appropriate blue circle outward (to
enlarge) or inward (to shrink).

o

Click and drag a
blue circle.

|

Cluster: Before

Cluster: After

5. To reshape the cluster (for example, to include a nearby point): Click and drag the
appropriate white circle in the direction you want the cluster to be stretched.

Click and drag a
white circle.

d

Cluster: Before

Cluster: After

6. To move the cluster: Click and drag the cluster to move it to the desired position.

Adjust stringency
The software assigns No Call status to datapoints that are too far from their cluster line.
You can change the number of standard deviations from cluster lines to the datapoints
that are included in the genotype call.

1. In the OpenArray software, select the Point tab.

2. In the Stringency field, enter a positive number (for example, 2) or enter Infinity.
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3. Click Apply. The software assigns No Call status to any datapoints that are farther
from the cluster than the value entered. No Call datapoints are black.

Scatter Plot for C__29086771_20

FAM Intensity
8503

aaaaa

p /|
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1761

1515 1974 2434 2893 3353 3812 212 731 5191
vic

Adjust tolerance

You can adjust how close a datapoint in one cluster can be to an adjacent cluster line
before the software assigns No Call status.

1. In the OpenArray software, select the Point tab.

2. In the Tolerance field, enter a standard deviation value.

Note: Larger tolerance values result in more No Call datapoints.

3. Click Apply. The software assigns No Call status to any points that are within the
tolerance value of more than one cluster line. No Call datapoints are black.

Scatter Plot for C__29086771_20
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Set Don't Call samples
To prevent a sample from being called by the software:
1. In the Samples pane or Scatter Plot, select the sample.

2. Click Don’t Call. In the Scatter Plot, the datapoint for the selected sample turns
cyan.

3. To include the datapoint back in the analysis, select it, then click Auto in the
Samples pane.

BE File Edit Actions Tools Help

Scatter Plot for C__29086771_20
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¢ 345115.. |7 20x 230 1] G0t 7560
c aze02.. |8 20% 250 1] HO1
G 402 8 20x 2a0 u AD2
C  12406.. |10 20% 250 u B02
C 32378.. 11 20x 230 u coz
c 1s14... |12 20X 250 u D02 sa1r A .
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BIAT4 VY vy BIA74.1.0  |AZal N N .
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BIATA VY vy BIAT45.0 |ABal Samples are cyan. s
BIATA VY vy BIAT480  |A7al
BIAT4 2% vy BIA747.0 |ABal
BIAT4 VF VF BIA748.0  |Afal s S
BIAT4 vy vy BIAT42.0 | Allal N N
BlA74 VF VF BIA74.100  |Allal * *
BIAT4 Mo Call No Call BIAT411.0 | AlZal < +
BIAT4 VE VF BIA74.12.0  |Blal . *
BIAT4 2% VY BIA74.13.0  |B2al %0
BIATA % vy BIA74.14.0  |B3al
BIATA Mo Call No Call BIA74.15.0 | Bdal
BIATA VY vy BIA74.180 |BSal
BlAT4 vy vV BIA7417.0 | BBal 1761 P4
BIAT4 VF VF BIA74.18.0  |B7al .
BIAT4 vy vy BIA74.12.0  |Boal
BIAT4 vy vy BIA74.20.0 |B8al
BIAT4 Vv vy BIA7421.0 | B10al
BIAT4 vy vy BIA74220  Bllal ® 1515 1974 234 2693 3353 3812 112 a1 5191
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Don't Call Outlier

Exclude genotyping clusters from analysis

You can configure the software to identify fewer than three genotypes. For example, if
you know your samples do not include any FAM dye homozygotes, you can remove
the FAM dye from the analysis.

To exclude a 1. Select the Draw tab.

genotyping cluster
using the Draw tab
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2. In the Scatter Plot, select the appropriate genotyping cluster, then press the
DELETE key. The genotyping cluster disappears from the Scatter Plot; in the
Clusters Present area, the corresponding genotype (FAM, Het, or VIC) is
automatically deselected. The software analyzes the data without the excluded
genotyping cluster.

Scatter Plot for C__29086771_20
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3. To include the genotyping cluster back in the analysis:
a. In the Point or Draw tab, select the excluded genotype: FAM, Het, or VIC.
Or

b. Redraw the cluster (see “Draw genotyping clusters” on page 101).

To exclude a 1. Select the Point or Draw tab.
genotyping cluster
using the Clusters
Present area

N

In the Clusters Present area, deselect the genotype (FAM, Het, or VIC), you do
not have. The genotyping cluster disappears from the Scatter Plot. The software
analyzes the data without the excluded genotyping cluster.

Scatter Plot for C__29086771_20
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this assay.
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3. To include the genotyping cluster back in the analysis:

a. In the Point or Draw tab, select the excluded genotype: FAM, Het, or VIC.
Or

b. Redraw the cluster (see “Draw genotyping clusters” on page 101).

Draw genotyping clusters

Note: When you create a new genotyping cluster, the software automatically deletes
the previously configured cluster for that genotype.

1. In the OpenArray software, select the Draw tab.

2. Select the appropriate drawing tool for the genotyping cluster you want to
recreate (for example, # ). Or select Tools » Draw <dye> Tool (where <dye> is
FAM, Het, or VIC). The software deletes the previously configured cluster for
that genotype.

3. In the Scatter Plot, click and draw a line around all the datapoints you want to
include in the new genotyping cluster.

. f  Click and drag
) the draw tool.

Cluster: Before

I
3 o
e o
£ of
, R o

Cluster: After
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(Optional) Modify project files

Project files (*.nix) are the files you view and modify in the OpenArray software. You
can modify project files as follows:

* Add plate data files (*.spd) (this page)
* Remove plate data files (*.spd) (page 103)
¢ Set project parameters (page 103)

Note: For more information on project files, see page 64.

Add plate data files (*.spd]

1. In the OpenArray software, click Add to open the Add/Remove Plate Files dialog
box. The software displays the plate data files (*.spd) currently in the project.

2. Click Add File, then browse to and select the plate data file(s) you want to add.
Note: To select multiple plate data files, press and hold the CTRL or SHIFT key.

#iAdd/Remove Plate Files

BIA?4 spd
BIA?E spd
BIAE spdl

Files Included In Project

Done

‘ Add File. ‘ Cancel

3. Click Open. The software:

¢ Displays the selected plate data files in the Add/Remove Plate Files dialog
box.

¢ Copies the run data from the plate data file to the project file.
Note: When you add a plate data file, the software copies the run data from
the plate data file to the project file. The files are not linked; that is, any

changes you make in the project file (*.nix) are not made in the
corresponding plate data file (*.spd).

4. Click Done. The software automatically calls the genotypes for the revised group
of plate data files, using your current settings.
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Remove plate data files (*.spd]

1. In the OpenArray software, click Add to open the Add/Remove Plate Files dialog
box. The software displays the plate data files (*.spd) currently in the project.

2. Select the plate data file to remove, then click Remove Files. The software:

* Removes the selected plate data files from the Add/Remove Plate Files
dialog box.

* Removes the run data for the selected plate data files from the project file.
Note: When you remove a plate data file from a project, the genotyping calls for the

samples in that plate data file are lost. In addition, the genotyping calls for the
remaining samples in the project change.

#iAdd/Remove Plate Files

Files Included In Project

Remove Files ‘ Add File. ‘ Save Files. ‘ Cancel

3. Click Done. The software automatically calls the genotypes for the revised group
of plate data files, using your current settings.

Set project parameters

IMPORTANT! When you set project parameters, the settings are applied to the current
project file and any future project files.

1. In the OpenArray software, select Edit » Project Settings to open the Project
Settings dialog box.
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(Optional] Modify project files

2. Select the Typical tab, then edit the parameters as needed:

Typical Tab Parameter Action
SiProject Settings » Stringency Enter a positive number (for examplg, ?.0] or enter Infinity to
represent a number of standard deviations. After you save the
Ty’]m‘“fm”l parameters, the software assigns a No Call status to any
Gy | datapoints that are further from the cluster line than the
Toemrce [E entered value.
Mode [Panttoge <]
Tolerance Enter a positive number (for example, 2.5) to indicate how
: :ZA‘MCL;;t|p‘ close a datapoint in one cluster may be to an adjacent cluster
B 10 Chstrs Preser line. After you save the parameters, the software assigns a
r— No Call status to any datapoints that are within the specified
@ I Showostiers standard deviations of two cluster lines.
W Show Cluster Lines
¥ Show Colors Mode From the dropdown menu, select the mode (Point or Draw)
you most frequently work within as your default. After you
A ot | concel save the parameters, the corresponding tab appears in front.
Clusters Deselect the genotypes you do not have. For example, if you
Present know your samples do not include any FAM dye homozygotes,

deselect FAM.

View Settings

Select the items (outliers, cluster lines, colors] to display in
the Scatter Plot.

3. Select the Advanced tab, then edit the parameters as needed:

Advanced Tab

#iProject Settings

Typical Advanced \

System Logging Level  |Some Information -
¥ Auto Classify Data in Draw Mode

I” Enhanced Spread Display

Parameter

System
Logging Level

Action

The system default is Some Information. Only adjust this value
when asked by an Applied Biosystems service representative.

Auto Classify
Data in Draw
Mode

Deselect this mode if you do not want the software to
automatically call genotypes on the Draw tab.

Restare

Il Defaults

aK Cancel

Enhanced
Spread Display

If checked, the software attempts to remove noise from data
in the project.

4. Click OK to save the parameters. The software applies all parameters to all

assays.
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(Optional) Publish data

Publish data for use in reports, spreadsheets, and so on. You can:

* Copy and paste Scatter Plots (this page)
* Export genotype tables (this page)
* Export *.csv files (page 106)

Copy and paste Scatter Plots

You can copy and paste the Scatter Plots into other software applications, such as
Microsoft® PowerPoint Software.

1. (Optional) In the OpenArray software, zoom in on an area of the Scatter Plot (see
step 5. on page 86).

2. Click in the plot area, then select Edit » Copy.

3. Paste the Scatter Plot into the appropriate software application.

Export genotype tables

You can export genotype information from your project in a table format. The table
includes the following information:

* Genotyping plate serial number
* Sample ID
* Sample description

* Genotype calls

1. Select the appropriate tab to export from (the Point or Draw tab).

Note: The Point and Draw tabs in the OpenArray software are not connected. For
example, when you analyze data in the Point tab, the Draw tab does not reflect that
analysis. Before you export genotyping results, be sure that the appropriate tab is
active.

2. In the OpenArray software, select File » Export Genotype Table to open the
Export Genotype Table dialog box.

TagMan® OpenArray® Genotyping Getting Started Guide 105



5 Chapter 5 Analyze the Run Data
(Optional) Publish data

3. Select Export Individual Genotypes.

Note: Do not select Export Consensus Genotypes or Export Individual and
Consensus Genotypes. These functions are not currently supported.

Genotype Tahle Options

& Export Indivicdual Genotypes
" Export Consensus Genotypes

" ExportIndividual and Consensus Genotypes

™ Transpose Output

QK Cancel |

4. Select the row and column contents:

¢ If you want each row to contain sample information and each column to
contain assay information, deselect Transpose Output.

¢ If you want each row to contain assay information and each column to
contain sample information, select Transpose Output.

5. Click OK to open a save dialog box.

6. Browse to a save location, name the file, then click Save. A *.csv file is saved to the
specified location.

7. To view the exported table, open it in Microsoft® Excel Software or another
spreadsheet application.

A [ B [ C [ D \ E [ F [
| 1 |OpenArray.SeriglNumber  Sample.SamplelD  Sample.Description  C__29086771_20.Genotype  C__28086771_20.Consensus Genotype  C__3168989_10.Genotype
| 2 |BIATA VY VY VY
| 3 |BIATA VY VY VY
| 4 |BIATA VY WY VF
| 5 |Blars VY | lv v
| 6 |BIAT4 VY VY VF
| 7 |BIAT4 VY VY VY
| & |BIAT4 VY VY VF
| 9 |BIATA VY VY VF
| 10 |BIATA VF VF VF
| 11 |BIATA VY VY VF
| 12 |BIATA VF VF VY
| 13 |BIATA No Call No Call No Call
| 14 |BIATA VF VF No Call
| 15 |BIATA VY VY No Call
| 16 |BIATA VY VY VY
| 17 |BIATA No Call No Call VF
| 18 |BIATA VY VY VF
| 18 |BIATA VY VY VY

Export *.csv files

You can export data from your project as a comma-delimited file (*.csv). The *.csv file
includes (but is not limited to) the following data:

* Assay information from the plate setup file (*.spf)

e Sample information
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Genotype calls and associated parameters

¢ Fluorescence intensity data

1.

Select the appropriate tab to export from (the Point or Draw tab).

Chapter 5 Analyze the Run Data
(Optional] Publish data

5

Note: The Point and Draw tabs in the OpenArray software are not connected. For
example, when you analyze data in the Point tab, the Draw tab does not reflect that
analysis. Before you export genotyping results, be sure that the appropriate tab is

active.

2. In the OpenArray software, select File » Export CSV. The following message

appears:

OpenArray™ SNP Genotyping Analysis Software

L

[~ Don't show this message again

You have chosen to export this file as a .csv (comma separated values) fle, Once the exportis complete, the .csv file wil not open in the SNP Genotyping software, Itis
recommended that you save this fle first as a .nix flle. Do you wish to proceed with the export to .csv?

Note: Exported *.csv files cannot be reopened in the OpenArray software. Applied
Biosystems recommends that you save the project file (*.nix) before exporting the *.csv
file.

3.

Click OK to close the message and open a save dialog box.

4. Browse to a save location, name the file, then click Save. A *.csv file is saved to the
specified location.
5. To view the exported *.csv file, open it in Microsoft® Excel Software or another
spreadsheet application.
A [ B [ ¢ [ b | E [ F | ¢ H I J K L M M

| 1 |VersionInf Versioninf Versioninf OpenArray OpenArray Opendrray OpenArray OpenArray OpenArray OpenArray Opendrray OpenArray OpenArray Opendrray O
| 2 |OpenArrey1.0.181.3 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 3 |OpenArrey1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 4 |Openarrey1.0.181.3 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 5 |OpenArrey1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 6 |OpenArrey1.0.181.3 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 7 |Openarrey1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 8 |OpenArrey1.0.181.3 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 9 |OpenArrey1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 10 [Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 11 [Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 12 [Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 13 |Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 14 [OpenArrey1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 15 [Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 16 [Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 17 [Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 18 [Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
| 19 |Openarrey 1.0.181.2 1/BIAT4 4 12 8 8 45 45 05 05 03 TRUE
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(Optional) Perform downstream analysis

Features

You can perform downstream analysis with Applied Biosystems AutoCaller™
Software. The AutoCaller software is a SNP genotyping analysis tool and client-server
program that you can use to efficiently analyze, edit, and compare genotyping assays
run on the OpenArray® system.

The AutoCaller software allows you to:

Import data from the OpenArray software project files, then manage the datain a
database.

Search the database for assays using specific search criteria.

Easily view data in a variety ways (plots, statistics, status codes, and so on).
Edit data (your edits are saved to the database).

Overlay data from multiple plates.

Export data.

Export to the AutoCaller software

108

1.

In the OpenArray software, select File » Export to Applied Biosystems
AutoCaller™... to open a save dialog box.

Browse to a save location, name the file, then click Save. An *.xml file is saved to
the specified location.

To import the file into the AutoCaller software, refer to the Applied Biosystems
AutoCaller™ Software User Guide.
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This appendix covers:

Contact Applied Biosystems. ........... .. .. i i 109
Required materials........ ... ... 110
Computer. ... ... 111
OpenArray® AutoLoader and accesSOTies . . ... .....ouurerenenenannn.... 112
OpenArray® instrument . . ... .....ouueitn i 114

Contact Applied Biosystems

Contact an Applied Biosystems service representative with questions regarding
preventative maintenance of the OpenArray® platform.

You may be asked for your software version, instrument firmware version, and/or
instrument serial number. To access this information:

1.

Be sure that you are on a computer that is connected to the OpenArray®
instrument.

In the OpenArray® SNP Genotyping Analysis Software, select Help » About.

IMPORTANT! Only an Applied Biosystems service representative should clean or
service components not covered in this appendix.
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Required materials

Required materials

110

Product

Source

Part Number

For the computer

OpenArray® SNP Genotyping Analysis Applied Biosystems 20441

Software Installation CD The CD ships with the
OpenArray® platform.

Backup storage (for example, CDs) User-supplied -—

For the OpenArray® AutolLoader and accessories

Clean, dry cloth ' Major laboratory -—
suppliers (MLS)

Ethanolt MLS -—

Bleach, 10%" - MLS —

(Optional) Filtered 100% compressed nitrogen | MLS -—

gas or residue-free compressed air canister,

for drying the plate holder, tip blocks, and

plate guides

(Optional) Hand-held spray attachment for the | MLS —

compressed gas/air canister

For the OpenArray® instrument

Powder-free nitrile gloves MLS -—

M4 hex wrench MLS —

12-inch Contec non-laser edge polyknit cloths | VWR PNHS1212

Ethanol® MLS -_—

Clean, dry cloth MLS -—

T For the SDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer. Before
handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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Install the software

Appendix A Maintenance
Computer

An Applied Biosystems service representative installs the OpenArray® SNP
Genotyping Analysis Software on the system computer. You can also install the
OpenArray software on other computers not connected to the instrument (for
example, your office computer).

Use the TagMan® OpenArray® Genotyping Software Installation CD that is shipped
with the OpenArray® platform. Software installation takes approximately 5 minutes.

1.

Insert the Installation CD in your CD drive. A message appears stating that files
are being extracted.

Note: If Microsoft®.Net Runtime v1.1 is not installed, the installation program
prompts you to install it. Select Yes.

Verify that the Installation Wizard appears, but do not click Next yet.

From the Start menu, select My Computer. If folders are not listed in the left
pane, select Folders in the My Computer toolbar to make them visible.

At the prompt, select to install software that is NOT FOR INSTRUMENT
CONTROL USE.

In the Installation Wizard, click Next. Enter your name and organization. If there
are multiple user accounts on this computer, select whether you want to install
the software for all users or just yourself, then click Next.

Click Next again to select the default directory for the plate setup files (*.spf).
When the Ready to Install window appears, click Next. The installation wizard

installs the software. When a message appears stating the software is successfully
installed, click Finish.

Open the software for the first time

1.

On the computer, start the OpenArray software:
e Double-click the software icon ki .
or

* Select Start » All Programs » BioTrove » OpenArray® SNP Genotyping
Analysis Software <version number> » OpenArray® SNP Genotyping
Analysis Software.

Click I Accept to accept the License Agreement.
If you have spyware removal software installed on this computer, you may

receive messages regarding changes in the registry. Enable registry updates for
the software.
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Clean the hard drive

Periodically remove plate data files (*.spd) from the instrument computer. The *.spd
files contain run (imaging and genotyping) data and are located in the images folder:

<drive>:\images\<run date><run number>
where:

<drive> is the computer drive on which the OpenArray software is installed. The
default installation drive is the C: drive.

<run date> is the date the run was performed.
<run number> is the chronological run number.

Before removing the *.spd files, be sure to:
1. Close the OpenArray software.

2. Back up the *.spd files (that is, save the files to another location).

OpenArray® AutoLoader and accessories

Clean the exterior
Clean the outside of the AutoLoader by wiping with a clean, dry cloth. Do not use
solvents.

Clean the interior
If liquids or other materials spill inside the AutoLoader:

1. Press the power switch on the back of the AutoLoader turn it off, then unplug the
power cord from the electrical outlet.

Power
Switch Power
Cord

2. Call your Applied Biosystems service representative.
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OpenArray® Autoloader and accessories

Calibrate the AutoLoader

The AutoLoader automatically calibrates each time it is turned on and each time
someone stops the AutoLoader. To calibrate the AutoLoader at another time, on the
Welcome screen, press the button under HOME.

Clean the accessories

After each use, clean the following AutoLoader accessories:

* OpenArray® Plate Guide Set
e OpenArray® AutoLoader Tip Block
* OpenArray® AutoLoader Plate Holder

To clean the AutolLoader accessories:

1. Soak the plate guide, tip block, and/or plate holder in 10% bleach for at least
10 minutes.

2. Rinse with water, then rinse with ethanol.

3. Letthe parts completely air dry. If they are needed immediately, wipe with paper
towels and spray with compressed nitrogen gas.
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OpenArray® instrument

Clean the lens

IMPORTANT! The lens is a vital part of your instrument and is easily scratched. Always
handle the lens gently and never drop it. If the lens is damaged and needs to be
replaced, you will not be able to operate your NT instrument until Applied Biosystems
can ship you a new lens.

If condensation or dirt builds up on the lens:
1. Put on powder-free nitrile gloves.

2. With an M4 hex wrench, unscrew all six screws on the lid by turning counter-
clockwise.

y\

3. Remove the metal ring and the O-ring.
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4. Place your hand underneath the lens and carefully pop it out of position. Remove
the lens, touching only the outside edge.

5. Spray a polyknit cloth with ethanol, then wipe the lens until there are no streaks
on the lens.

6. Clean the lid:
a. Spray a polyknit cloth with ethanol.
b. Clean the lip of the lid.
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c. Spread the polyknit cloth on the block and close the lid for 10 seconds.

d. Clean the fingers on the top of the lid individually.

7. Be sure that the lens is frosted side up (it should be in a concave position, like a
bowl), then place the lens back into the OpenArray® instrument.

8. Place the O-ring on the lip, then place the metal ring on top of the O-ring.
9. With the M4 hex wrench, partially screw all screws on the lid by turning
clockwise. After all are flush, but not tight, screw them in all the way. To reduce

pressure on the lens, tighten screws on two opposite sides, then on the other two
opposite sides.

Clean the sample block

Clean the OpenArray® instrument sample block by wiping with a clean, dry cloth. Do
not use solvents.

Clean the exterior

Clean the outside of the OpenArray® instrument by wiping with a clean, dry cloth. Do
not use solvents.
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This appendix covers:

Loading sample...............

Imaging

Analysis .....................

Miscellaneous ................

APPENDIX B

Troubleshooting

For more troubleshooting information, refer to the TagMan® OpenArray® Genotyping
Troubleshooting Guide (PN 4401671).

Loading sample

Message

Begins with: “Please cycle
power”

Circumstances

The OpenArray® AutolLoader
needs to be power-cycled.

Resolution

Turn the AutolLoader off for a few seconds, then
switch it back on. It should clear itself.

Begins with: “Error in
subsystem”

A technician may need to look at
the AutolLoader.

Contact Applied Biosystems.

Imaging

Message

Do you want to keep blocking
this program?

OpenArray® SNP Genotyping
Software must be run with
English (United States) language
settings.

Warning! This application was
previously shut down
improperly. Data from the
previous run may have been
lost.

Circumstances

Windows firewall software is
attempting to protect your
computer by making sure you
want to launch new software.

At this time, the software
requires that English (United
States] is selected.The default
setting on your computer is not
English (United States).

The electrical power failed and
shut down your computer.
Or

You closed the application in the
Windows Task Manager.

Resolution

Click Unblock to close the LogServer window.
Click Unblock to close the CyclopsSupervisor
window.

Close the software. Select Start » Control Panel »
Regional and Language Settings. On the Regional
tab, select English (United States) as the
Standards and Formats setting. Restart the
software.

Data from the run currently in progress are lost.
Restart the instrument and computer and re-
image the TagMan® OpenArray® Genotyping
Plates for the current run. Data from previous
runs are preserved.
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Imaging

Message

Circumstances

Resolution

OpenArray® SNP Genotyping
Software encountered errors

while loading the following files.

Couldn’t open document.

The following file(s) already exist
in the document and will not be
loaded.

This document contains 50
OpenArray® plates - the

maximum allowed. Please
create a new document to

perform additional experiments.

There is not enough free space
on which to save the new data.
Please move or delete files on
your hard drive so that 3.59 GB
are available.

You have attempted to add a
plate data file (*.spd) that you do
not have permission to open, is
already open, or is not valid.

You have attempted to open a
project file (*.nix) that you do not
have permission to open, is
already open, or is not valid.

You have attempted to add plate

data files (*.spd) that are already
included in the project.

Projects can contain a maximum
of 50 plate data files (*.spd). You
have attempted to add or image
files that would exceed the
maximum number.

Before you begin each run, the
software automatically verifies
whether you have enough
storage space for the imaging
data you are about to collect. You
receive this message if you have
limited storage space remaining
on your hard drive.

Click OK to close the message. Check to make
sure you are adding a valid file and that you have
access to it. If needed, ask your administrator to
upgrade your permissions level.

Click OK to close the message. Check to make
sure you are opening a valid file and that you have
access to it. If needed, ask your administrator to
upgrade your permissions level.

Click OK to close the message. Add plate data files
not already in the project.

Add the plate data files to a different project.
Or

Open a different project file for imaging the
genotyping plates.

Check the amount of disk space on your hard
drive. Select Start » My Computer, then double-
click Local Disk. Review your system storage
space statistics (right side, blue bar). Move or
delete files as needed to make space, then image
the genotyping plates.

Plate File Not Found. Load CD
for this Plate or choose Locate
File.

Failed to open Plate File. The file

may be corrupt or may require a
newer version of this software.

Camera not ready. Please wait
and try again when status bar
shows Camera is initialized.

Plate File in Position x Not
Loaded.

The software matches the serial
number of each genotyping
plate with its corresponding
plate setup file (*.spf). You
receive this message if no match
is found.

The software cannot open the
plate setup file (*.spf).

After you enter serial numbers
in the Input Plate Serial
Numbers dialog box, you click
Image. This message appears if
the camera is not ready.

The plate setup file (*.spf) is not

located in the default folder

where the software can locate it.

If the plate setup file is located in another
directory, click Locate Files, browse to the
appropriate directory, then select the file.

Or

If you did not copy the files from the CD that was
shipped with your order to your computer, insert
the CD and copy the files.

Reload the plate setup file from the CD the was
shipped with your order. If this does not resolve the
problem, contact Applied Biosystems.

Wait until the red indicator circle in the status bar
(lower right corner) turns green. Click Image
again.

Load the plate setup file from the CD that was
shipped with your order to the default folder:
C:\Program Files\BioTrove\PLATEFILES.

Or

Click Browse, browse to the folder where the plate
setup file is stored, select it, then click OK.
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Message

Circumstances

Appendix B Troubleshooting
Imaging

Resolution

Multiple OpenArray® plates with
the same serial number have
been selected.

OpenArray® plate serial number
is identical to existing one in
document.

The same serial number was
given for the highlighted
positions in the Input Plate
Serial Numbers dialog box.

The serial number in the
highlighted position is the same
as a genotyping plate serial
number already in your project
file (*.nix).

Check the serial numbers on the genotyping
plates you loaded in the instrument. Re-enter the
correct serial numbers by scanning or typing
them. Click Image.

Check the serial numbers on the genotyping
plates you loaded in the instrument. Re-enter the
correct serial numbers by scanning or typing
them. Click Image.

Failed to import the file named
Xyz.

Either the sample information
file (*.csv] you are trying to
import is invalid or you do not
have permission to open it.

Click OK to close the message. Check to make
sure you are opening a valid *.csv file and that you
have access to it. If needed, ask your administrator
to upgrade your permissions level.

Please select a valid plate file
before editing the sample
applied to it.

Stop Imaging has been selected.
Are you sure that you want to
stop imaging?

The plate setup file (*.spf) for the
genotyping plate for which you
are trying to add sample
information is either not found
or corrupt.

You can stop imaging while in
progress. From the Actions
menu, select Stop Imaging. This
message appears.

If the file is not found:

Load the plate setup file from the CD that was
shipped with your order to the default folder:

C:\Program
Files\BioTrove\PLATEFILES.OrClick Browse,
browse to the folder where the plate setup file is
stored, select it, then click OK.

If the file is corrupt, contact Applied Biosystems.

To continue imaging, click No.

To stop imaging, click Yes. This message appears:
“If you stop imaging, the project file will contain
partially collected imaging data. Do you want to
keep the partially collected data?” Click Yes, No, or
Cancel. If you click Cancel, imaging will resume.

Status bar reads: “Stopping
Imaging”

The instrument is responding to
your request to stop imaging.

Wait until the instrument is ready, then open the
door to retrieve your genotyping plates.

Status bar reads: “Failed to
detect the instrument.”

The computer is not able to
communicate with the
instrument.

If you are running the software on a computer that
is not connected to the instrument (for example,
your office computer], no action is required.

Otherwise, power off the instrument, then make
sure all cables are securely connected. Power on
the instrument and restart the software. If the
message reappears after following this procedure,
contact Applied Biosystems.

Status bar reads: “Initializing
Camera...”

The camera inside the
instrument is initializing.

Wait until the status bar updates, indicating that
the camera is initialized. If the camera fails to
initialize, the status bar will read: “Failed to detect
the instrument.”
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Analysis

Message

Circumstances

Resolution

Status bar reads: "LED Test
Waiting for CCD Temp <1.0°C.”

Status bar reads: “Waiting for
CCD Temp <1.0°C.”

The camera needs to cool off
before imaging can proceed.

Wait until the status bar updates, indicating that
the camera temperature is now below 1.0 °C. If
the camera fails to cool, the status bar reads:
“Failed to detect the instrument.”

Status bar reads: “LED Test
Running.”

The LED calibration test is
running.

Wait until the status bar updates, indicating the
LED test is complete.

Status bar reads: “LED Test
Passed.”

Your instrument is ready to
image.

Continue with the imaging procedure.

Analysis

Message

Circumstances

Resolution

Warning! This application was
previously shut down
improperly. Unsaved data from
the previous run may have been
lost.

The electrical power failed and
shut down your computer.

Or

You closed the application in the
Windows Task Manager.

You will lose any unsaved data. Restart your
computer and continue editing.

OpenArray® SNP Genotyping
Software encountered errors

while loading the following files.

You have attempted to add a
plate data file (*.spd) that you do
not have permission to open, is
open in another software
application, or is not valid.

Click OK to close the message. Check to make
sure you are adding a valid plate data file and that
you have access to it. If needed, ask your
administrator to upgrade your permissions level.

Couldn’t open document.

You have attempted to open a
project file (*.nix] that you do not
have permission to open, is open
in another software application,
or is not valid.

Click OK to close the message. Check to make
sure you are opening a valid file and that you have
access to it. If needed, ask your administrator to
upgrade your permissions level.

The following file(s) already exist
in the document and will not be
loaded.

You have attempted to add plate
data files (*.spd) that are already
included in the project.

Click OK to close the message. Add plate data files
not already in the project.

This document contains 50
OpenArray® plates - the

maximum allowed. Please
create a new document to

perform additional experiments.

Projects can contain a maximum
of 50 plate data files (*.spd). You
have attempted to add or image
files that would exceed the
maximum number.

Add the plate data files to a different project.
Or

Open a different project file for imaging the
genotyping plates.

Are you sure that you want to
apply these settings to all items
in this project?

You are updating settings for all
assays in a project file (*.nix).
From the Edit menu, select
Project Settings.

Click OK to confirm your changes.
Or
Click Cancel.
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Message

Circumstances

Appendix B Troubleshooting
Analysis

Resolution

Only one character allowed in
the allele.

In the Reporter 1 Sequence and
Reporter 2 Sequence columns
of the Assays pane, you can
enter the one-letter character
representing the reporter dye
being measured.

Enter the appropriate character in the column:
F (FAM™ dye)
V (VIC® dye)

N (non-specific)

You must have enough
datapoints for the number of
clusters you are finding in your
data. Deselect genotypes or
auto-call datapoints as
appropriate. Clustering Not
Possible.

You may not reduce the number
of clusterable datapoints below
the number of clusters you are
finding in your data. Deselect
genotypes or auto-call
datapoints as appropriate.

There are not enough datapoints
to represent selected genotypes
for the current assay.

You need to add datapoints to the cluster. You can:

Select datapoints that are Don’t Call or Outlier,
then select Auto in the Samples pane to have them
called again.

Move the exclusion area so that more datapoints
are called.

Image more genotyping plates into this project file
(*.nix).

Failed to save xyz.nix.

Failed to export the Genotype
table to xyz.csv.

Failed to export data to xyz.csv.

You have chosen to export this
file as a .csv (comma separated
values] file. Once the export is
complete, the .csv file will not
open in the SNP Genotyping
software. It is recommended
that you save this file first as a
.nix file. Do you wish to proceed
with the export to *.csv?

You have attempted to save a file
on a local or network location for
which you do not have
permission, or the file is open in
another software application, or
the file is on a drive that does
not have enough storage space.

Since *.csv files can’t be re-
opened as project files, you need
to save both a project file (*.nix)
and a *.csv file.

Make sure you have permission to save to the
location. If needed, ask your administrator to
upgrade your permissions level. Make sure there
is adequate space available; you can move or
delete files to make space.

If desired, select Don’t show this message again.
Click OK. The Export CSV dialog box appears.
Select an option:

To export the file, browse to the appropriate
directory, enter a filename, then click Save.

To cancel the export, click Cancel.

This document has been
modified. Do you want to save?

When you close a file containing
changes you haven't saved, you
are asked if you want to save
your changes.

To save changes, click Yes.
To close without saving the changes, click No.

To return to the file and continue making edits,
click Cancel.
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Miscellaneous

Miscellaneous

Message

Circumstances

Resolution

Failed to save License
Agreement.rtf.

You attempted to save the
software license agreement in a
folder that don’t have
permission to save in, or that
does not have enough disk
space available.

Click OK to close the message. Check to make
sure you have access to the folder and that it has
enough storage space. Retry the save. If
necessary, save the license agreement in a
different folder.

This application encountered an
error and must quit.

This application encountered an
error. Please save all changes
and quit the application.

The software has encountered a
problem that forces it to close.

If possible, save your changes to a location that is
different from where you previously saved them.
Contact Applied Biosystems.
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APPENDIX C

DNA Calculator

Before you load the TagMan® OpenArray® 384-Well Sample Plate with DNA samples
(page 43), you need to calculate the required:

e Starting concentration of the genomic DNA (gDNA) sample (this page)

Note: The starting concentration is the concentration of the gDNA sample prior to
adding it to the sample plate.

* Volume of TagMan® OpenArray® Genotyping Master Mix and (if needed) water
(page 125)

About the Sample Tracking & Calculator Tool

The Sample Tracking & Calculator Tool is a spreadsheet created with the Microsoft®
Excel® Software. You can use the tool to quickly calculate the required amounts of
gDNA and master mix. Applied Biosystems provides the Sample Tracking &
Calculator Tool during training.

Calculate the starting concentration of gDNA

Applied Biosystems recommends that you add 250 haploid copies of gDNA to each
through-hole of a TaqgMan® OpenArray® Genotyping Plate. To calculate the required
concentration:

1. Determine the genome size in megabases (Mb) or determine the picogram (pg)
quantity:

* Genome size — For humans, 1 haploid copy of human genome is equal to
3300 Mb.

* Picogram (pg) quantity (C-value) — For humans, the pg quantity is 3.3.

Note: To obtain the genome size or pg quantity for other species, go to
www.genomesize.com, or use another trusted source.

2. Browse to and open the Sample Tracking & Calculator Tool to start the Excel
software.

3. Select the gDNA Calculator tab.
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Calculate the starting concentration of gDNA

4. In the spreadsheet, enter the:
¢ Genome size in the yellow box.

Or
¢ Picogram quantity in the blue box.

How do | determine the starting concentration?

Step 1a: Enter the size of the genome (in terms of length) in the yellow box, or

Step 1b: |Enter the pg quantity of hapliod genome from www.genomesize.com (C value) in the blue box
Step 2: Convert the size of 1 haploid copy from length to mass

Step 3: Convert the mass of 1 haploid copy from pg to ng

Step 4: Multiply the mass of 1 haploid copy by the # of copies required per through-hole (250 copies)
Step 5: Divide the mass of 250 copies by the volume per through-hole

Step 6: Multiply the concentration of gDNA required per through-hole by the dilution factor constant (2)
Step 7: Result = required starting concentration in (ng/uL) (round to the nearest whole number)

Result Result Units
Genome Size (enter number) 6] Mb
Conversion from length to mass 978Mb = 1pg 0.0000 0.0000 [eke]
Conversion from pg to ng 1pg = 0.001ng 0.0000 0.0000 ng
Multiply mass by # of copies 250 copies 0.0000 0.0000 ng
Divide mass by through-hole volume 0.033uL 0.0000 0.0000 ng/uL
Multiply concentration by dilution factor 2 0.0000 0.0000 ng/uL
|Resu|t = Required starting ng/uL 0 ng/uL

The Sample Tracking & Calculator Tool calculates the required starting
concentration (in ng/uL) of the gDNA sample, rounded to the nearest whole

number.

Example

The figures below show the results for human DNA.
Note: The final result may vary slightly due to rounding off by the calculator.

Entered genome size

ﬁL& Result Units

Genome Size (enter number) 3300 > Mb
Conversion from length to mass 978Mb = 1pg 3.3742 0.0000 [o]¢]
Conversion from pg to ng 1pg = 0.001ng 0.0034 0.0000 ng
Multiply mass by # of copies 250 copies 0.8436 0.0000 ng
Divide mass by through-hole volume 0.033uL 25.5624 0.0000 ng/ulL
Multiply concentration by dilution factor 2 51.1247 0.0000 ng/ulL
Result = Required starting ng/ul 51 ng/uL

Calculated
result

124 TagMan® OpenArray® Genotyping Getting Started Guide



Genome Size (enter number)
Conversion from length to mass
Conversion from pg to ng

Multiply mass by # of copies

Divide mass by through-hole volume
Multiply concentration by dilution factor
Result = Required starting ng/ulL

Appendix C DNA Calculator
Calculate the volume of master mix and water

Entered pg quantity

Result Re%ult Units
0 Mb
978Mb = 1pg 0.0000 3.3000 pg
1pg = 0.001ng 0.0000 0.0033 ng
250 copies 0.0000 0.8250 ng
0.033uL 0.0000 25.0000 ng/uL
2 0.0000 50.0000 ng/uL
50 ng/uL
Calculated
result

Calculate the volume of master mix and water

The Master Mix Calculator aids in determining:

* The volume of gDNA and water required per subarray
e The total volume of TagMan® OpenArray® Genotyping Master Mix and water

required for the project

1. Browse to and open the Sample Tracking & Calculator Tool to start the Excel

software.

2. Select the Master Mix Calculator tab.

3. In the spreadsheet, enter the required values in Steps 1 through 3.

Note: The tool automatically enters the gDNA value from the gDNA Calculator.

How much Master Mix should | prepare?

Step 1: |Enter total humber of samples

Step 2: |Enter the overage for pipetting error (e.g., 10% = 1.1)

Step 3: |Enter your gDNA concentration

o

*Takes the ng/ulL from the gDNA calculator

Starting uL per Total uL (including
Component Concentration | Reaction overage)
TaqMan OpenArray Master Mix 2x 2.50 0.0
Nuclease Free Water #DIV/Q! #DIV/0!
gDNA* 50 #DIV/Q!
Total Volume 5.00 0.0

The Sample Tracking & Calculator Tool calculates the required volumes.

Note: The calculated results are the volumes required for the overall project, not

the volumes required per subarray.
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Calculate the volume of master mix and water

Example

126

The figure below shows the results for 48 samples, a 10% overage, and a stock gDNA
concentration at 100 ng/uL (thus, requiring a dilution).

Since the gDNA is double the required concentration, only 1.25 pL of gDNA is
required; 1.25 pL of nuclease-free water is required to bring the final sample volume to

2.5 uL.
Entered values

How much Master Mix should | prepare? \\
Step 1: |Enter total number of samples 48
Step 2: |Enter the overage for pipetting error (e.g., 10% = 1.1) ( 1.1
Step 3: |Enter your gDNA concentration 100
Starting uL per Total uL (including
Component Concentration | Reaction o e)
TagqMan OpenArray Master Mix 2x 2.50 / 132.0\
Nuclease Free Water 1.25 \_ 660 /
gDNA* 50 1.25
Total Volume 5.00 264.0 |
*Takes the ng/ulL from the gDNA calculator
Calculated
results
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APPENDIX D

Thermal Cycler Protocols

This appendix covers:

Dual Flat Block GeneAmp® PCR System 9700. . ... ..o.ovvnenenanennn... 127
Bio-Rad® thermal cycler protocol . ... ..........uiuiuereininininanannn. 127
Protocol . . ... 128
Thermo Electron PX2 thermal cycler protocol............................ 129

Dual Flat Block GeneAmp® PCR System 9700

For the thermal cycling protocol, refer to the Dual Flat Block GeneAmp® PCR System
9700 User Guide.

Bio-Rad® thermal cycler protocol

Before programming the thermal cycler, Applied Biosystems recommends installing

the Slide Chambers Dual-Block Alpha Unit on the thermal cycler base. If you have a

multi-bay base unit, install the Slide Chambers Unit in Bay 1. An error may occur if a
program is created with a different block installed on the thermal cycler base.

For additional information and assistance, contact an Applied Biosystems service
representative.
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Protocol

Protocol

128

1. Be sure that the black side of the TagMan® OpenArray® Genotyping Case is
facing up on the block.

2. Follow the manufacturer’s directions to thermal cycle the sealed TagMan®
OpenArray® Genotyping Plates.

3. If you must re-program the Bio-Rad thermal cycler, select the Block method, then
enter the following:

Step Temperature and Time

1 0.8 °C/second to 95.5°C

2 91.0 °C for 10:00

3 0.5°C/s to 51.0°C

4 51.0 °C for 0:23

5 0.8°C/s to 53.5°C

6 53.5 °C for 0:30

7 0.8°C/s to 54.5°C

8 54.5°C for 0:13

9 0.8°C/s to 97.0°C

10 97.0 °C for 0:22

11 0.8°C/s to 92.0°C

12 92.0 for 0:07

13 Goto 3, 49 times

14 20 °C for 5:00

15 4°C Hold

16 End
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Thermo Electron PX2 thermal cycler protocol

Thermo Electron PX2 thermal cycler protocol

1.

Be sure that the black side of the TagMan OpenArray Genotyping Case is facing

up on the block.

Follow the manufacturer’s directions to thermal cycle the sealed genotyping

plates.

. Place a rubber compression pad on top of the genotyping plates.

If you must reprogram the PX2 thermal cycler, enter the following in the EDIT menu:

Edit menu
STAGE 01 STEP 01
TEMP 925 '
TIME 0:10:00
STAGE 01 STEP 02
TEMP 0.00 '
TIME 0:00:00

View menu
STAGE 01 STEP 01
TEMP 92.5 TIME 00:10:00
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00
STAGE 01 STEP 02
TEMP 0.05 TIME 00:00:00
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00

Note: For STAGE 01, STEP 02, the VIEW menu displays the temperature as TEMP 0.05, even though you have entered
0.00. In the EDIT menu, you can enter only 0.00 °C or a temperature that is >4 °C.

STAGE NUMBER 01
NUMBER OF CYCLES 01
HOLD TEMP 00.0
STAGE 02 STEP 01
TEMP 97.5 '

TIME 0:00:35

STAGE 02 STEP 02
TEMP 96.5 '

TIME 0:00:11

STAGE 02 STEP 03
TEMP 52.7 '

TIME 0:01:55

STAGE 02 STEP 04
TEMP 0.00 '

TIME: 0:00:00

STAGE NUMBER 01

NUMBER OF CYCLES 01

HOLD TEMP 00.0

STAGE 02 STEP 01

TEMP 97.5 TIME 00:00:35
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00
STAGE 02 STEP 02

TEMP 96.5 TIME 00:00:11
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00
STAGE 02 STEP 03

TEMP 52.7 TIME 00:01:55
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00
STAGE 02 STEP 04

TEMP 0.07 TIME 00:00:00
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00

Note: For STAGE 02, STEP 04, the VIEW menu displays the temperature as TEMP 0.07, even though you have entered
0.00. In the EDIT menu, you can enter only 00.0 °C or a temperature that is >4 °C.
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Edit menu

STAGE NUMBER 02
NUMBER OF CYCLES ' 50
HOLD TEMP 00.0
STAGE 03 STEP 01
TEMP 25.00
TIME 0:02:00
STAGE 03 STEP 02
TEMP 0.00 '
TIME 0:00:00
STAGE NUMBER 03
NUMBER OF CYCLES 01
HOLD TEMP 00.0
STAGE 04 STEP 01
TEMP 0.00
TIME 0:00:00

130

View menu
STAGE 02
NUMBER OF CYCLES 50
HOLD TEMP 00.0
STAGE 03 STEP 01
TEMP 25.00 TIME 00:02:00
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00
STAGE 03 STEP 02
TEMP 0.00 TIME 00:00:00
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00
STAGE NUMBER 03
NUMBER OF CYCLES 01
HOLD TEMP 00.0
STAGE 04 STEP 01
TEMP 0.00 TIME 00:00:00
TEMP INC 0.00 TIME INC 00:00
GRADIENT 00 RAMP 0.00
STAGE NUMBER 04
NUMBER OF CYCLES 01
HOLD TEMP 00.0
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APPENDIX E

Instrument Warranty Information

Computer configuration

Applied Biosystems supplies or recommends certain configurations of computer
hardware, software, and peripherals for use with its instrumentation. Applied
Biosystems reserves the right to decline support for or impose extra charges for
supporting nonstandard computer configurations or components that have not been
supplied or recommended by Applied Biosystems. Applied Biosystems also reserves
the right to require that computer hardware and software be restored to the standard
configuration prior to providing service or technical support. For systems that have
built-in computers or processing units, installing unauthorized hardware or software
may void the Warranty or Service Plan.

Limited product warranty

Limited warranty

Applied Biosystems warrants that all standard components of its OpenArray® system
will be free of defects in materials and workmanship for a period of one (1) year from
the date the warranty period begins. Applied Biosystems will repair or replace, at its
discretion, all defective components during this warranty period. After this warranty
period, repairs and replacement components may be purchased from Applied
Biosystems at its published rates. Applied Biosystems also provides service
agreements for post-warranty coverage. Applied Biosystems reserves the right to use
new, repaired, or refurbished instruments or components for warranty and
post-warranty service agreement replacements. Repair or replacement of products or
components that are under warranty does not extend the original warranty period.

Applied Biosystems warrants that all optional accessories supplied with its
OpenArray® system, such as peripherals, printers, and special monitors, will be free of
defects in materials and workmanship for a period of ninety (90) days from the date
the warranty begins. Applied Biosystems will repair or replace, at its discretion,
defective accessories during this warranty period. After this warranty period, Applied
Biosystems will pass on to the buyer, to the extent that it is permitted to do so, the
warranty of the original manufacturer for such accessories.

With the exception of consumable and maintenance items, replaceable products or
components used on or in the instrument are themselves warranted to be free of
defects in materials and workmanship for a period of ninety (90) days.

Applied Biosystems warrants that chemicals and other consumable products will be
free of defects in materials and workmanship when received by the buyer, but not
thereafter, unless otherwise specified in documentation accompanying the product.
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Limited product warranty

Applied Biosystems warrants that for a period of ninety (90) days from the date the
warranty period begins, the tapes, diskettes, or other media bearing the operating
software of the product, if any, will be free of defects in materials and workmanship
under normal use. If there is a defect in the media covered by the above warranty and
the media is returned to Applied Biosystems within the ninety (90) day warranty
period, Applied Biosystems will replace the defective media.

Applied Biosystems does not warrant that the operation of the instrument or its
operating software will be uninterrupted or error free.

Warranty period effective date

Warranty claims

Any applicable warranty period under these sections begins on the earlier of the date
of installation or ninety (90) days from the date of shipment for hardware and software
installed by Applied Biosystems personnel. For all hardware and software installed by
the buyer or anyone other than Applied Biosystems, and for all other products, the
applicable warranty period begins the date the product is delivered to the buyer.

Warranty claims must be made within the applicable warranty period, or, for
chemicals or other consumable products, within thirty (30) days after receipt by the
buyer.

Warranty exceptions

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation with incompatible solvents or
samples in the system; operation outside of the environmental or use specifications or
not in conformance with the instructions for the instrument system, software, or
accessories; improper or inadequate maintenance by the user; installation of software
or interfacing, or use in combination with software or products, not supplied or
authorized by Applied Biosystems; and modification or repair of the product not
authorized by Applied Biosystems.

THE FOREGOING PROVISIONS SET FORTH APPLIED BIOSYSTEMS’ SOLE
AND EXCLUSIVE REPRESENTATIONS, WARRANTIES, AND OBLIGATIONS
WITH RESPECT TO ITS PRODUCTS, AND APPLIED BIOSYSTEMS MAKES NO
OTHER WARRANTY OF ANY KIND WHATSOEVER, EXPRESSED OR IMPLIED,
INCLUDING WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE, WHETHER ARISING FROM A
STATUTE OR OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR
USAGE OF TRADE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

Warranty limitations

132

THE REMEDIES PROVIDED HEREIN ARE THE BUYER'S SOLE AND
EXCLUSIVE REMEDIES. WITHOUT LIMITING THE GENERALITY OF THE
FOREGOING, IN NO EVENT SHALL APPLIED BIOSYSTEMS BE LIABLE,
WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE
(INCLUDING WITHOUT LIMITATION, ANY TRADE PRACTICE, UNFAIR
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COMPETITION, OR OTHER STATUTE OF SIMILAR IMPORT) OR ON ANY
OTHER BASIS, FOR DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, MULTIPLE,
CONSEQUENTIAL, OR SPECIAL DAMAGES SUSTAINED BY THE BUYER OR
ANY OTHER PERSON OR ENTITY, WHETHER OR NOT FORESEEABLE AND
WHETHER OR NOT APPLIED BIOSYSTEMS IS ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES, INCLUDING WITHOUT LIMITATION, DAMAGES
ARISING FROM OR RELATED TO LOSS OF USE, LOSS OF DATA, FAILURE OR
INTERRUPTION IN THE OPERATION OF ANY EQUIPMENT OR SOFTWARE,
DELAY IN REPAIR OR REPLACEMENT, OR FOR LOSS OF REVENUE OR
PROFITS, LOSS OF GOOD WILL, LOSS OF BUSINESS, OR OTHER FINANCIAL
LOSS OR PERSONAL INJURY OR PROPERTY DAMAGE.

NO AGENT, EMPLOYEE, OR REPRESENTATIVE OF Applied Biosystems HAS
ANY AUTHORITY TO MODIFY THE TERMS OF THIS LIMITED WARRANTY
STATEMENT OR TO BIND APPLIED BIOSYSTEMS TO ANY AFFIRMATION,
REPRESENTATION, OR WARRANTY CONCERNING THE PRODUCT THAT IS
NOT CONTAINED IN THIS LIMITED WARRANTY STATEMENT, AND ANY
SUCH MODIFICATION, AFFIRMATION, REPRESENTATION, OR WARRANTY
MADE BY ANY AGENT, EMPLOYEE, OR REPRESENTATIVE OF

APPLIED BIOSYSTEMS WILL NOT BE BINDING ON APPLIED BIOSYSTEMS,
UNLESS IN A WRITING SIGNED BY AN EXECUTIVE OFFICER OF

APPLIED BIOSYSTEMS.

THIS WARRANTY IS LIMITED TO THE BUYER OF THE PRODUCT FROM
APPLIED BIOSYSTEMS AND IS NOT TRANSFERABLE.

Some countries or jurisdictions limit the scope of or preclude limitations or exclusion
of warranties, of liability, such as liability for gross negligence or wilful misconduct, or
of remedies or damages, as or to the extent set forth above. In such countries and
jurisdictions, the limitation or exclusion of warranties, liability, remedies or damages
set forth above shall apply to the fullest extent permitted by law, and shall not apply to
the extent prohibited by law.
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Damages, claims, and returns

Damages

Claims

Returns

134

If shipping damage to the product is discovered, contact the shipping carrier and
request inspection by a local agent. Secure a written report of the findings to support
any claim. Do not return damaged goods to Applied Biosystems without first securing
an inspection report and contacting Applied Biosystems Technical Support for a
Return Authorization (RA) number.

After a damage inspection report is received by Applied Biosystems, Applied
Biosystems will process the claim unless other instructions are provided.

Do not return any material without prior notification and authorization.

If for any reason it becomes necessary to return material to Applied Biosystems,
contact Applied Biosystems Technical Support or your nearest Applied Biosystems
subsidiary or distributor for a return authorization (RA) number and forwarding
address. Place the RA number in a prominent location on the outside of the shipping
container, and return the material to the address designated by the Applied
Biosystems representative.
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This appendix covers:

Instrumentation safety. ............ ... . 136
Symbols on instruments . ............. . 136
Locations of safety labels on instruments. ............................... 137
General instrument safety . .............. i 138
Physical hazard safety . ......... ... ... .. i i 139
Electrical safety ........ ... ... . 140
Bar code scanner laser safety ............. ... i 140
Workstation safety ............... 141
Safety and electromagnetic compatibility (EMC) standards ................ 141
Chemical safety. . ... 143
General chemical safety............ ... i 143
OGS . 143
Chemical waste safety ... 144
Biological hazard safety. ........... ... i 145
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Instrumentation safety

Symbols on instruments

Electrical The following table describes the electrical symbols that may be displayed on Applied
symbols on Biosystems instruments.
instruments

Symbol Description

Indicates the On position of the main power switch.

Indicates the Off position of the main power switch.

Indicates a standby switch by which the instrument is switched on to the
Standby condition. Hazardous voltage may be present if this switch is on
standby.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference
of another instrument. This is not a protected ground terminal.

Indicates a protective grounding terminal that must be connected to earth
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Ne+eCG 0 —

Indicates a terminal that can receive or supply alternating or direct current
or voltage.

Safety symbols The following table describes the safety symbols that may be displayed on Applied
Biosystems instruments. Each symbol may appear by itself or with text that explains
the relevant hazard (see “Safety labels on instruments” on page 11). These safety
symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that occur
in the text of this and other product-support documents.

Symbol

Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

B> >

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard
and to proceed with appropriate caution.

136

TagMan® OpenArray® Genotyping Getting Started Guide



Environmental

Appendix F Safety
Instrumentation safety

Description

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate
caution.

Indicates the presence of a biological hazard and to proceed with appropriate
caution.

Indicates the presence of a radiological hazard and to proceed with
appropriate caution.

Indicates the presence of a slipping hazard and to proceed with appropriate
caution.

B B> B P

Indicates the presence of an ultraviolet light and to proceed with appropriate
caution.

The following symbol applies to all Applied Biosystems electrical and electronic

symbols on products placed on the European market after August 13, 2005.
instruments
Symbol Description
Do not dispose of this product as unsorted municipal waste. Follow
—

4

local municipal waste ordinances for proper disposal provisions to reduce
the environmental impact of waste electrical and electronic equipment
(WEEE).

European Union customers:

Call your local Applied Biosystems Customer Service office for equipment
pick-up and recycling. See www.appliedbiosystems.com for a list of
customer service offices in the European Union.

Locations of safety labels on instruments

The OpenArray® platform includes the following warning on the OpenArray® Case

Sealing Station:

Hazard
symbol

English

Francais

CAUTION! UV LIGHT HAZARD.

UV light may harm ATTENTION! Dangers liés aux rayons UV. Les

your skin and eyes. Keep at least 25 cm distance. rayons UV peuvent endommager votre peau et vos

yeux. Gardez une distance de plus de 25 cm.
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General instrument safety

Moving and lifting
the instrument

Moving and lifting
stand-alone
computers and
monitors
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C WARNING! PHYSICAL INJURY HAZARD. Use this product only as specified
in this document. Using this instrument in a manner not specified by Applied
Biosystems may result in personal injury or damage to the instrument.

WARNING! PHYSICAL INJURY HAZARD. Using the instrument in a manner
not specified by Applied Biosystems may result in personal injury or damage to
the instrument.

C CAUTION! For safety information related to the centrifuge and thermal cycler,
refer to the manufacturer's documentation.

A CAUTION! PHYSICAL INJURY HAZARD. The instrument is to be moved and

positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been
installed, do not attempt to lift or move the instrument without the assistance of
others, the use of appropriate moving equipment, and proper lifting techniques.
Improper lifting can cause painful and permanent back injury. Depending on
the weight, moving or lifting an instrument may require two or more persons.

C CAUTION! Do not tip the OpenArray® instrument on end. Tipping damages
the instrument hardware and electronics and is an unsafe practice.

C WARNING! Do not attempt to lift or move the computer or the monitor without
the assistance of others. Depending on the weight of the computer and/or the
monitor, moving them may require two or more people.
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Things to consider before lifting the computer and/or the monitor:
* Make sure that you have a secure, comfortable grip on the computer or the
monitor when lifting.

* Make sure that the path from where the object is to where it is being moved is
clear of obstructions.

* Do not lift an object and twist your torso at the same time.

¢ Keep your spine in a good neutral position while lifting with your legs.

e Participants should coordinate lift and move intentions with each other before
lifting and carrying.

¢ Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the Ensure that anyone who operates the instrument has:

instrument * Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Safety Data Sheets (SDSs). See “About SDSs”

on page 143.
Cleaning or CAUTION! Before using a cleaning or decontamination method other than
decontaminating the those recommended by the manufacturer, verify with the manufacturer that the
instrument proposed method will not damage the equipment.

Physical hazard safety

Ultraviolet light WARNING! ULTRAVIOLET LIGHT HAZARD. Looking directly at a UV light
#\ source can cause serious eye damage. Never look directly at a UV light source
and always prevent others from UV exposure. Follow the manufacturer’s
recommendations for appropriate protective eyewear and clothing.

Compressed gases A WARNING! EXPLOSION HAZARD. Pressurized gas cylinders are potentially
explosive and can cause severe injury if not handled properly. Always cap the
gas cylinder when it is not in use and attach it firmly to the wall or gas cylinder
cart with approved brackets or chains.

Moving parts C WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and cut.
Keep hands clear of moving parts while operating the instrument. Disconnect
power before servicing the instrument.

Solvents and WARNING! PHYSICAL INJURY HAZARD. Always wear eye protection when
pressurized fluids working with solvents or any pressurized fluids.
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Electrical safety

Power

Overvoltage rating

A WARNING! ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the OpenArray® instrument without its instrument panels
in place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

C WARNING! ELECTRICAL HAZARD. Grounding circuit continuity is required
for the safe operation of equipment. Never operate equipment with the
grounding conductor disconnected.

C WARNING! ELECTRICAL HAZARD. Use properly configured and approved
line cords for the voltage supply in your facility.

WARNING! ELECTRICAL HAZARD. Plug the OpenArray® platform
components into properly grounded receptacles with adequate current capacity.

The OpenArray® platform has an installation (overvoltage) category of II, and is
classified as portable equipment.

Bar code scanner laser safety

Laser
classification

Laser safety
requirements

140

The bar code scanner included with the OpenArray® platform is categorized as a
Class 2 (II) laser.

Class 2 (II) lasers are low-power, visible-light lasers that can damage the eyes. Never
look directly into the laser beam. The scanner is designed to prevent human access to
harmful levels of laser light during normal operation, user maintenance, or during
prescribed service operations.

WARNING! LASER HAZARD. Class 2 (II) lasers can cause damage to eyes.
Avoid looking into a Class 2 (II) laser beam or pointing a Class 2 (II) laser beam
into another person’s eyes.
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Correct ergonomic configuration of your workstation can reduce or prevent effects
such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring
your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD.
These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static
unhealthy positions, contact pressure, and other workstation environmental
factors.

To minimize musculoskeletal and repetitive motion risks:

¢ Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Safety and electromagnetic compatibility (EMC) standards

U.S. and Canadian
safety
standards

\WTERTE,

€.

Canadian EMC
standard

European safety and
EMC
standards

C€

This section provides information on:

¢ U.S. and Canadian safety standards
¢ Canadian EMC standard

¢ European safety and EMC standards
¢ Australian EMC Standards

The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray®
instrument have been tested to and comply with the standards:

UL 61010-1:2004, 2nd Edition/CSA-C22.2 No. 61010-1, “Safety Requirements for
Electrical Equipment for Measurement, Control and Laboratory Use: Part 1: General
Requirements.”

The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray®
instrument have been tested to and comply with ICES-001, Issue 3: “Industrial,
Scientific, and Medical Radio Frequency Generators.”

Safety

The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray®
instrument meet European requirements for safety (Low Voltage Directive 73/23/EEC).
This instrument has been tested to and complies with standards EN 61010-1:2001,
“Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements.”

The OpenArray® instrument has been tested to and complies with the standard:

EN 60825-1, “Radiation Safety of Laser Products, Equipment Classification,
Requirements, and User’s Guide.
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Australian EMC
Standards

C
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EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 89/336/EEC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray®
instrument have been tested to and comply with standard AS/NZS 2064, “Limits and
Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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General chemical safety

Chemical hazard

warning

Chemical safety
guidelines

SDSs

About SDSs

Obtaining
SDSs
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C WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer to

the Safety Data Sheet (SDS) provided by the manufacturer, and observe all
relevant precautions.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste in
a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

To minimize the hazards of chemicals:

Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. (See “About SDSs” on page 143.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the SDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments of
hazardous chemicals to new customers. They also provide SDSs with the first
shipment of a hazardous chemical to a customer after an SDS has been updated. SDSs
provide the safety information you need to store, handle, transport, and dispose of the
chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to
replace the appropriate SDS in your files.

The SDS for any chemical supplied by Applied Biosystems is available to you free 24
hours a day. To obtain SDSs:

1.

2.

Go to www.appliedbiosystems.com, click Support, then select SDS.
In the Keyword Search field, enter the chemical name, product name, SDS part

number, or other information that appears in the SDS of interest. Select the
language of your choice, then click Search.
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Chemical waste safety

Chemical waste
hazards

Chemical waste
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3.

Find the document of interest, right-click the document title, then select any of the
following:

¢ Open - To view the document
* Print Target — To print the document

e Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the SDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

C CAUTION! HAZARDOUS WASTE. Refer to Safety Data Sheets and local

regulations for handling and disposal.

C WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

C WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste in

a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

safety guidelines .

144

To minimize the hazards of chemical waste:

Read and understand the Safety Data Sheets (SDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste
material and meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the SDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national environmental
and health regulations.
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If potentially hazardous waste is generated when you operate the instrument, you
must:

* Characterize (by analysis if necessary) the waste generated by the particular

applications, reagents, and substrates used in your laboratory.
Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Biological hazard safety

General biohazard

C WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-040-
00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/ nara/cfr/waisidx_01/
29c¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov
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Documentation and Support

System documentation

The following documents are available for the OpenArray® system:

Document Description Part

number

OpenArray® System Site Provides information on preparing the customer site for the 4401171

Preparation Guide OpenArray® system.

TagMan® OpenArray® Genotyping | Provides troubleshooting information for TagMan® OpenArray® 4401671

Troubleshooting Guide Genotyping. To be used in conjunction with the TagMan® OpenArray®

Genotyping Getting Started Guide.

TagMan® OpenArray® Genotyping = Provides procedures for performing TagMan® OpenArray® 4377476

Getting Started Guide Genotyping.

TagMan® OpenArray® Genotyping | Describes the overall workflow and provides brief procedures for 4400402

Quick Reference Card performing TagMan® OpenArray® Genotyping.

Related documentation

When using this Guide, you may find the documents listed below useful. To obtain
this and additional documentation, see “Obtaining support” on page 148.

Document Part number
Application Note: DNA Genotyping from Human FFPE Samples - Reliable 137AP04-01
and Reproducible
Bioinformatic Evaluation of a Sequence for Custom TagMan® SNP 4371003
Genotyping Assays
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204
TagMan® SNP Genotyping Assays Protocol 4332856
User Bulletin: Human DNA Sample Quantification Protocol Using the 4342582
RNase P Kit
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Obtaining support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:

* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.

* Search through frequently asked questions (FAQs).
¢ Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, SDSs, certificates of analysis, and
other related documents.

¢ Download PDF documents.
¢ Obtain information about customer training.

¢ Download software updates and patches.
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cluster center

cluster lines

DNA sample

Don’t Call

duplicate

Entr,
home(s)

load position

No Call

OpenArray® 384-
Well Sample Plate

OpenArray®
platform

Outlier

plate guide

Glossary

On the Scatter Plot, the user-defined or automatically calculated cluster midpoint of
datapoints for each genotype. Each cluster center appears as a circled X.

On the Scatter Plot, lines that bisect each genotype cluster drawn from the clustering
axis to the cluster center.

The DNA from any source of interest (for example, tissue, whole organism, cDNA
library).

User designation that a datapoint not be called. The point appears cyan in the Scatter
Plot.

An assay is performed “in duplicate” when two through-holes are filled with the same
assay/sample combination and a genotype call is made.

Abbreviation for ENTER used in the OpenArray® AutoLoader display.
An OpenArray® AutoLoader operation that calibrates robotic movement.

The OpenArray® AutoLoader configuration when you begin loading samples into a
TagMan® OpenArray® Genotyping Plate.

Designation in the software that a genotype has not been called. The point appears
black in the Scatter Plot.

A 384-well microtiter plate that you use with the OpenArray® AutoLoader to transfer
DNA samples to a TagMan® OpenArray® Genotyping Plate. Also referred to as the
sample plate.

Refers to all of the instrument components of the system, including:

e OpenArray® AutoLoader
» OpenArray® Case Sealing Station
* OpenArray® instrument

» Computer, running the OpenArray® SNP Genotyping Analysis Software

User designation that a datapoint not be included in genotype calculations or
displayed in the Scatter Plot.

When loading sample with the OpenArray® AutoLoader, the part that you place over
the sample plates to ensure the correct samples are loaded. Two plate guides are
included in the OpenArray® Plate Guide Set.
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plate holder
replicate

stringency

TagMan® assay

TagMan®
OpenArray®
Genotyping Plate
target

tip block

tolerance
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Accurately positions the TagMan® OpenArray® Genotyping Plate for sample loading
in the OpenArray® AutoLoader.

Experiments performed with the OpenArray® system, in which the same sample/assay
combination is performed in multiple through-holes.

In the software Point tab, the number of standard deviations from cluster lines to the
datapoints that are included in genotype calls. Datapoints greater than this number of
standard deviations are automatically assigned No Call status.

The assays that are dried-down and preloaded into the TagMan® OpenArray®
Genotyping Plate. You can select any combination of the following TagMan assays:

e TagMan® SNP Genotyping Assays
* Custom TagMan® SNP Genotyping Assays
¢ TagMan® Drug Metabolism Genotyping Assays

A 63-mm x 19-mm mid-density reaction plate. The TagMan® OpenArray® Genotyping
Plate consists of individual through-holes that are preloaded with a TagMan® assay.
Available in six formats. Also referred to as the genotyping plate.

The nucleic acid sequence that you want to amplify and detect.

The OpenArray® AutoLoader Tip Block. The tip block holds 48 loader tips for sample
loading with the OpenArray® AutoLoader.

In the software Point tab, datapoints that are too close to more than one cluster line to
be accurately genotyped. These datapoints are automatically assigned No Call status.
Tolerance is the indicator of excessive closeness, measured in standard deviations.
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Symbols

*nix. See project file 64
*.spd. See plate data file 65
*.spf. See plate setup file 64

A

add columns 74
adjust genotyping clusters 94
adjust stringency 97
adjust tolerance 98
analysis
troubleshooting 120
view results 82
Applied Biosystems
contacting for maintenance 109
Assays pane
column descriptions 84
view data 83
Auto functions 92
AutoCaller Software, downstream analysis 108
Auto-Classification Wizard 94

biohazardous waste, handling 145

C

calibrate the OpenArray AutoLoader 113
CAUTION, description 9
chemical safety 143
chemical waste safety 144
clean
genotyping case 60
hard drive 112
OpenArray AutoLoader accessories 113

OpenArray AutoLoader exterior and interior 112

OpenArray® instrument exterior 116
OpenArray® instrument lens 114
OpenArray® instrument sample block 116
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Index

clustering parameters
adjust genotyping clusters 94
adjust stringency 97
adjust tolerance 98
draw genotyping clusters 101
exclude genotyping clusters 99
modify 92
set Don’t Call samples 99
set outliers 93
columns
add 74
Assays pane 84
delete 76
Samples pane 92
components 13
compressed gases, safety. See also pressurized fluids,
safety 139
computer
clean hard drive 112
configuration requirement 131
install OpenArray software 111
maintenance 111
open OpenArray software for first time 111
purpose 13
technical support for altered configuration 131

D

DANGER, description 10
data collection 14
data files 64
datapoint colors 87
delete columns 76
DNA
procedure for preparing human DNA 24
quality 23
quantity 23
template amount 23
Don’t Call samples 99
downstream analysis, AutoCaller Software 108
drag and drop 94
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Index

draw genotyping clusters 101

E

electrical safety 140

electromagnetic compatibility standards. See EMC
standards

EMC standards 141

enter sample information 68, 69, 71
ergonomics, safety 141

error messages 117, 120, 122
exclude genotyping clusters 99
export *.csv file 106

export genotype table 105

F

format 128 40
format 16 35
format 192 41
format 256 42
format 32 37
format 64 39

G

genotype table, export 105
genotyping case
cleaning 60
inserting genotyping plate into 58
sealing 58
genotyping clusters
Auto-Classification Wizard 94
drag and drop 94
draw 101
exclude 99
modify shape 96
genotyping experiments
components 17
how they work 17
mismatches 18
genotyping plate
assays 16
barcode on packaging 50
complete loading 61
formats 16, 34, 46
guidelines for handling 50
inserting into genotyping case 58
load the tip blocks 52
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ordering 46

overview 16

perform imaging 80

place in plate holder 50

place into OpenArray® instrument 79

prepare for loading 49

required materials 46

serial number 67

storage conditions 48

thermal cycling 61

view analysis results 82
guidelines

chemical safety 143

chemical waste disposal 144

chemical waste safety 144

handling genotyping plate 50

high-throughput loading 62

H

hard drive, clean 112

hazard icons. See safety symbols, on instruments 136
hazard symbols. See safety symbols, on instruments
hazards. See safety

high-throughput loading guidelines 62

I
imaging 80
perform 78
troubleshooting 117
IMPORTANT, description 9
installation category 140
instrument operation, safety 139

L

laser classification 140

laser safety
bar code scanner 140
requirements 140

lens 114

loading
complete for genotyping plate 61
genotyping plate 49
guidelines for high-throughput 62
tip blocks 52
troubleshooting 117
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maintenance 109, 127
computer 111
contact Applied Biosystems 109
OpenArray AutoLoader and accessories 112
OpenArray® instrument 114
required materials 110
mismatch, in genotyping experiments 18
modifying clustering parameters 92
moving and lifting safety
computers and monitors 138
instrument 138
moving parts, safety 139
MSDSs. See SDSs 143

N

no template controls 17

0

open a project file 82
OpenArray 384-Well Sample Plate. See sample
plate 15
OpenArray AutoLoader
calibrate 113
clean accessories 113
clean exterior and interior 112
illustration 54
maintenance 112
purpose 13
setup 55
OpenArray Case Sealing Station, purpose 13

OpenArray SNP Genotyping Analysis Software. See

OpenArray software 64

OpenArray software

add columns 74

add plate data file 102

adjust genotyping clusters 94

adjust stringency 97

adjust tolerance 98

Assays pane 83

Auto functions 92

Auto-Classification Wizard 94

data files 64

delete columns 76

drag and drop genotyping clusters 94

draw genotyping clusters 101

enter genotyping plate serial number 67
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import sample information 71
install on computer 111
manually enter sample information 69
messages 117, 120, 122
modify cluster shapes 96
modify clustering parameters 92
modify project files 102
open a project file 82
open for first time 111
plate data file 65
plate setup file 64
project file 64
publish data 105
remove plate data file 103
sample information file 65
Samples pane 88
Save function 92
Scatter Plot 85
set Don’t Call samples 99
set outliers 93
set project parameters 103
setup 66
starting 66
view results 82
OpenArray® instrument
clean the exterior 116
clean the lens 114
clean the sample block 116
commands 78
maintenance 114
perform imaging 80
place genotyping plate into 79
purpose 13
starting 66
ordering genotyping plate 46
outliers 93
overvoltage category (rating) 140

P

physical hazard safety 139
plate data file
add to project 102
description 65
remove from project 103
plate holder
placing genotyping plate in 50
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plate setup file
copy to computer 66
description 64
platform components 13
positive controls 17
prepare the DNA samples 23
procedure for human DNA 24
quality of DNA 23
quantity of DNA 23
prepare the genotyping plate
required materials 46
prepare the sample plate
required materials 22
pressurized fluids, safety 139
project file
add plate data file 102
description 64

exporting sample information from 30

modify 102

open 82

remove plate data file 103

set project parameters 103
project parameters 103
publish data 105

export *.csv file 106

genotype table 105

Scatter Plot 105

R

RA number. See return authorization number

radioactive waste, handling 145
repetitive motion, safety 141
replicates 17
required materials
maintenance 110
prepare the genotyping plate 46
prepare the sample plate 22
storage conditions 48

return authorization (RA) number 134

S

safety
bar code scanner 140

before operating the instrument 138

biological hazards 145
chemical 143
chemical waste 144
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safety
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import 71
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description 65
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illustration 33
overview 15, 33
prepare the DNA samples 23
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Samples pane
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Scatter Plot
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description 143
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standards
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sample plate 44
stringency 97
symbols, safety 136
system
maintenance 109, 127
workflow 19
system overview 13
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TagMan assays 16

TagMan OpenArray Genotyping Case. See genotyp-
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TagMan OpenArray Genotyping Plate. See genotyp-
ing plate 16

technical support, for computers with altered
configuration 131

thermal cycler 14
Bio-Rad protocol 127
qualified 61
Thermo Electron PX2 protocol 129
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loading 52
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miscellaneous 122
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ultraviolet light, safety 139
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